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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help

You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed Help

If you’re setting up an on-premise PeopleSoft environment, and your organization has firewall restrictions
that prevent you from using the hosted PeopleSoft Online Help, you can install the online help locally.
See Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

*  Application Fundamentals
» Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.

Copyright © 1988, 2022, Oracle and/or its affiliates. vii
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In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions

PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions

The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

... (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
Options are separated by a pipe (| ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

> This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.
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Preface

ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY CD TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

¢ Asia Pacific
*  Europe
e Latin America

¢ North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

e USF (U.S. Federal)

¢ E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We

are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.
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Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

» Using the PeopleSoft Online Help.
* Managing hosted Online Help.

* Managing locally installed PeopleSoft Online Help.

PeopleSoft FSCM Related Links

Oracle Help Center

Hosted Online Help

PeopleSoft Information Portal

My Oracle Support

Financial and Supply Chain Management information for Search Framework search engine can be found
in PeopleSoft Application Fundamentals documentation. For application specific information, see the
"Understanding Search Pages within Components " (Application Fundamentals) topic.

PeopleSoft Training from Oracle University

PeopleSoft Video Feature Overviews on YouTube

PeopleSoft Business Process Maps (Microsoft Visio format)

PeopleSoft Spotlight Series

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.

Follow Us

Icon Link

@ YouTube
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Link

Twitter@PeopleSoft Info.

PeopleSoft Blogs

LinkedIn
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Chapter 1

Getting Started With PeopleSoft Proposal
Management

PeopleSoft Proposal Management Overview

At any time in your business cycle, your organization may be faced with many service-related
opportunities. Organizations must make informed decisions about which opportunities to pursue based on
estimated cost and potential revenue. In addition, each opportunity may have multiple viable scenarios for
execution, with each having its own estimated costs.

In PeopleSoft Proposal Management, professional services organizations typically use proposals to
estimate what resources are required to pursue an initiative or potential service contract that is not yet
accepted. With PeopleSoft Proposal Management, you have the ability to:

* Create multiple projects for a proposal.

e Generate proposals from quotes in Order Capture.

» Create contracts and contract lines from proposals.

*  Copy proposal versions to new versions within a proposal or to new proposals.

» Pass proposed rates to the Activity Resource List (ARL) for billing.

* Control access to proposals using security that is based on user ID and department.

*  View overall proposal cost and billing information.

« Store and view relevant files, such as requests for proposals and terms and conditions.

Each proposal may have several different ways to approach the opportunity, provide services for the
proposal, or sell it to your client. For example, you might be presented with a project that could be done
in a number of different ways. Or you might want to create different versions to highlight the different
costs between completing an assignment in a short time frame using many resources and completing the
same assignment in a longer time frame with fewer resources. By creating several versions of the same
proposal, you can look at the problem from different angles and come up with a solution that is best for
you and your client.

You can use PeopleSoft Proposal Management to easily generate multiple proposal versions to find

the situation that best fits your business needs. Creating a detailed proposal for services involves
outlining activities, time lines, resource needs, cost amounts, bill amounts, and margin percentages. To
be responsive to customers and reduce costs, it is essential that you leverage the work that went into
the original proposal when creating a contract and projects for a customer. After a proposal is accepted,
organizations must move quickly from the sales mode to the execution mode.

The proposal that is accepted by the customer serves as a basis for generating the contract. You can
convert all the cost, revenue, billing terms, resource asset, material or other cost rates and resource, asset,
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material, or other bill rates, into a contract that can be used to bill the customer and recognize revenue.
This capability eliminates redundant data entry, increases accuracy, and reduces bill discrepancies.

Just as the proposal terms and conditions form the basis of the contract, project plans that are associated
with the proposal are used to generate projects. This eliminates the need to recreate critical project
information, such as the project activities, time lines, resource requirements, and project teams.

PeopleSoft Proposal Management gives you the ability to develop and administer project proposals to
expedite the closure of business opportunities and to reuse proposal versions for future engagements.

Note: To use all of the PeopleSoft Proposal Management functionality, you must also purchase
PeopleSoft General Ledger, PeopleSoft Project Costing, PeopleSoft Program Management, PeopleSoft
Contracts, Resource Management, and PeopleSoft Billing. The minimum requirements to use PeopleSoft
Proposal Management include the purchase of PeopleSoft Project Costing and PeopleSoft Contracts.

Life Cycle of a Proposal

This diagram shows a high-level view of proposal preparation and processing, beginning with preparing
the proposal versions, defining your projects, activities and resources, and then generating the proposal
and managing the project through its life cycle.

Proposal Preparation

Prepare proposal versions

-

Create projects, activities,
and resources

-

Select and commit version;
run Generate process

Proposal Processing

Create budget

Create contract aa B e detail lines

Define project team

Create rate templates | — i
requiraments

Create billing and revenue Create projects
recognition plans and activities

During proposal preparation, you can create as many proposal versions as needed and as many projects as
needed for each version.

If you want to begin defining resource requirements for a project before those requirements are approved
to incur costs against the project, you can optionally create a project resource team by selecting the
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Create Resources Team check box on the Maintain Version Estimate Detail page. This creates a project
in a Pending processing status in PeopleSoft Project Costing. The Create Resources Team process only
reserves the labor resource. In PeopleSoft Proposal Management, you can jump to the project from the
project ID link on the Resource Estimate page and the Maintain Version Estimate Detail page or the
Resource Team link on the Maintain Version Estimate Detail page. In PeopleSoft Program Management,
you can reserve, but not assign, resources to a pending project. The reservations appear on the resource's
schedule in Resource Management.

If you select a different proposal version after the resource team is created (but before the Pre-Spending
process is run), the system deletes any existing pending projects, project team structures, and activity
team structures for the versions that were created for previously selected versions.

If you want to start incurring costs against a proposal before it is approved, you can optionally run the
Pre-Spending process. This process creates projects and activities in PeopleSoft Project Costing without
creating a contract. The difference between creating projects using the Pre-Spending process and creating
projects by selecting the Create Resources Team check box on the Maintain Version Estimate Detail
page is that the Pre-Spending process creates projects in an Active processing status.

If you previously created a pending project by selecting the Create Resources Team check box, the
Pre-Spending process changes the processing status of projects on the current version from Pending to
Active. The Pre-Spending process changes the generate status on the Maintain Proposal page to Pre-Sales
Spending. You can still modify and add projects to the current version after you run the Pre-Spending
process. You are, however, locked in on the version on which Pre-Spending was run.

You can run the Contract Generation process when the proposal status is Committed. This process
generates the proposal into its various revenue and project tracking tables in PeopleSoft Contracts and
PeopleSoft Project Costing. You can select only one version of a proposal for contract generation.

Common Elements Used in Proposal Management topics

Term Definition

Account ChartField that identifies the nature of a transaction for
corporate accounts. This is a delivered PeopleSoft ChartField,
specific use of which is typically defined by your organization
during implementation of PeopleSoft General Ledger.

Activity The unit of work in PeopleSoft Project Costing that provides
a further breakdown of projects, usually into specific tasks.
Resources are assigned directly to activities within a project,
rather than being assigned directly to projects.

Analysis Type A three-character, user-definable identifier that enables you to
label the different types of costs in PeopleSoft Project Costing.
For example, you might want to track budgeted costs (BUD),

committed costs (COM), and actual costs (ACT).

Currency Code that identifies the type of currency for an amount, such
as USD (United States Dollar) or EUR (Euro).
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Term Definition

Department ChartField that indicates who is responsible for or affected by
the transaction.

Effective Date Date on which a table row becomes effective; the date that an

action begins. For example, if you want to close out a ledger
on June 30th, the effective date for the ledger closing would
be July 1st. This date also determines when you can view and
change the information. Pages and batch processes that use the
information use the current row.

EIP (enterprise integration point)enterprise integration point
(EIP), definition

An EIP is an instance of enterprise integration between your
PeopleSoft application and an external system or application:
a seamless connection between the two products to accomplish
a specific business purpose. EIPs represent the formal methods
that third-party applications use to exchange data elements.

Operating Unit

ChartField that is used to identify a location, such as a
distribution warehouse or sales center.

Process Monitor

This is a PeopleSoft tool that you can use to review the status

of scheduled or running processes. You can view all processes
to see the status of any job in the queue and control processes

that you initiated.

See PeopleTools: PeopleSoft Process Scheduler,
"Understanding PeopleSoft Process Scheduler.”

Product

ChartField that captures additional information useful for
profitability and cash flow analysis by product sold or
manufactured.

Program

ChartField that identifies groups of related activities, cost
centers, revenue centers, responsibility centers, and programs.
Tracks revenue and expenditures for programs.

Project

The highest level of hierarchical organization within
PeopleSoft Project Costing. PeopleSoft Project Costing
provides the structure to which activities and resources are
added.

Proposal projects obtain their numbering from PeopleSoft
Project Costing. This ensures continuity with the numbering
process when the proposal project becomes a real project. The
numbering process occurs when you run the generate process,
request pre-award spending, or create the project team.

Contract

A contract is a legal agreement between two or more parties.
This is the highest level entity within the PeopleSoft Contracts
module. Proposal numbering is obtained from PeopleSoft
Contracts and a proposal becomes a contract after you run the
generate process.

16
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Term

Definition

Proposal

A comprehensive estimate provided to a prospect or customer
that contains projects, activities, resources, labor, assets,
materials, and other projections. The proposal also includes

a time frame for the proposed work. A proposal can contain
multiple versions for modeling different scenarios prior to
finalizing and running the generate process. You can run

the generate process only once on the current version of a
proposal.

Proposal ID

A unique number that is assigned by PeopleSoft Contracts

to track the proposal throughout the proposal development

and Contract Generation process. This ID is derived from the
PeopleSoft Contracts auto numbering process and remains the
same after the Contract Generation process so that the proposal
and the contract contain the same ID.

Report ID

The report identifier.

Resource Transaction

Displays an individual cost or bill row within PeopleSoft
Project Costing. It is through resource transactions that
individual costs and types of costs are tracked. Each resource
transaction contains a cost, bill, and quantity, and other
identifiers of the cost that may have been entered.

Resource transactions are created when you receive
information from other systems, run allocations with project
resources as the target, or perform internal transactions such as
billing, project closure, or adjustments.

Resource Type

The Resource Transaction field in PeopleSoft Project Costing
that identifies the resource associated with a given cost.
Resource types may be general or specific depending on your
needs; they are used in conjunction with resource categories,
resource subcategories, and resource groups.

Run

This button takes you to the Process Scheduler request page,
where you can specify the location where a process or job runs
and the process output format.

See PeopleTools: PeopleSoft Process Scheduler,
"Understanding PeopleSoft Process Scheduler.”

Run Control ID

Code that identifies the run parameters for a report or process.

SetID

Code that represents a set of control table information or
tablesets. A tableset is a group of tables (records) necessary to
define your company's structure and processing options.
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Term Definition

Status In PeopleSoft Proposal Management, status is also used
to indicate the state of the proposal. The statuses used in
PeopleSoft Proposal Management include: Draft, Ready,
Denied, Committed, and Canceled.

Version To track different scenarios, multiple versions of proposals
are supported. Note that users can select only one version (the
current version) for sale. The other versions would, however,
still be visible.

Basic information, such as the proposal description, start
and end dates, customer information, and contacts, remain
the same for each version. To create a different version of
a proposal, users enter resource details for the projects and
activities that they want to associate with the proposal.

PeopleSoft Proposal Management Business Processes

This graphic lists the PeopleSoft Proposal Management business processes.

Proposal Preparation i aqd an—labar \Version Modeling
Estimation
Generate Process Budgeting*® Project Analysis*
Eill Creation” Reparting Proposal Copy

*These business processes are a part of the Proposal Management life cycle, however,
they are administered by Contracts, Project Costing, and Program Management.

The business process and integration topics discusses these business processes.

PeopleSoft Proposal Management Integrations

PeopleSoft Proposal Management integrates with PeopleSoft Program Management, Project Costing,
Contracts, CRM, Payables, General Ledger, Purchasing, Receivables, Resource Management, Billing,
Time and Labor, and Inventory.
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The integration touch points are depicted in this diagram.

Getting Started With PeopleSoft Proposal Management

PeopleSoft Enterprise Proposal Management
1 5
Program
Management v v J
Project Customer
> Cos]tin - » Contracts Relationship
¢ Management
—
A A A A A
L J
Payables P
»| General Ledger [~
Y P & Commitment [ A
Control
A A
Y L v
S — .
; Resource .
—
Purchasing [4—1 Receivables YCrErL e Billing
Time and
Labor — Inventory

Supplemental information about third-party application integrations is located on the PeopleSoft My

Oracle Support webs

ite.

PeopleSoft Proposal Management Implementation

PeopleSoft Setup Manager enables you to generate a list of setup tasks for your organization based on
the features that you are implementing. The setup tasks include the components that you must set up,

listed in the order in which you must enter data into the component tables, and links to the corresponding

documentation.

Because PeopleSoft Proposal Management is a solution that requires the installation of several different
applications, you must use Setup Manager separately for each application that you install. PeopleSoft
Proposal Management requires that you follow the order listed below when using Setup Manager:

1. PeopleSoft Project Costing
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2. PeopleSoft Program Management
3. PeopleSoft Contracts
4. PeopleSoft Proposal Management

PeopleSoft Financials also provides component interfaces to help you load data from your existing system
into PeopleSoft tables. Use the Excel to Component Interface utility with the component interfaces to
populate the tables:

Component Component Interface Reference

Account (GL_ACCOUNT) ACCOUNT _CF See "Account Page" (Application
Fundamentals).

Alternate Account (ALTACCT) ALTACCT _CF See "Understanding Alternate

Accounts" (Application Fundamentals).

Bank Branch Information (BANK TR_BANK BRANCH CI See "Understanding Bank

BRANCHPNL) Setup" (PeopleSoft Banks Setup and
Processing).

Budget Reference (BUDREF PNL) BUDGET_REF See "Budget Reference

Page" (Application Fundamentals).

Chartfield 1 (CHARTFIELD1) CHARTFIELD1 See "ChartField 1 Page" (Application
Fundamentals).

Chartfield 2 (CHARTFIELD?2) CHARTFIELD2 See "ChartField 1 Page" (Application
Fundamentals).

Chartfield 3 (CHARTFIELD3) CHARTFIELD3 See "ChartField 1 Page" (Application
Fundamentals).

Class Field (CLASS _PNL) CLASS CF See "Class Field Page" (Application
Fundamentals).

Contact Info (CONTACT INFO) CONTACT See "Setting Up and Maintaining

Contacts" (PeopleSoft Order to Cash
Common Information).

Customer Group Table (CUST_GROUP | CUSTOMER GROUP See "Customer Group Table
_TBL) Page" (PeopleSoft Order to Cash
Common Information).

Department (DEPARTMENT) DEPT_CF See "Department Page" (Application
Fundamentals).
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Component

Component Interface

Reference

Fund Code (FUND_DEFINITION)

FUND_CF

See "Fund Code Page" (Application
Fundamentals).

General Information (CUSTOMER _
GENERAL)

CUSTOMER_MAIN_CI
CUSTOMER_BILLTO CI
CUSTOMER_SOLDTO CI
CUSTOMER_SHIPTO_CI

CUSTOMER_MISC_CI

See "Adding General Customer
Information" (PeopleSoft Order to Cash
Common Information).

InterUnit Pair Maintenance (IU_INTER _
PR _BASIC)

IU_INTER_PR_BASIC

See "Interunit Pairs" (Application
Fundamentals).

InterUnit Template (IU_INTER
TMPLT)

IU_INTER_TMPLT

See "InterUnit Template
Page" (Application Fundamentals).

IntraUnit Template (IU_INTRA
TMPLT)

IU_INTRA_TMPLT

See "InterUnit Template
Page" (Application Fundamentals).

Ledgers for a Unit (BUSINESS UNIT
LED)

EM_BUS_UNIT LED

See "Defining Ledgers for a Business
Unit" (Application Fundamentals).

Operating Unit (OPERATING_UNIT)

OPER_UNIT _CF

See "Operating Unit Page" (Application
Fundamentals).

Product (PRODUCT) PRODUCT _CF See "Product Page" (Application
Fundamentals).

Program Code (PROGRAM PROGRAM _CF See "Program Code Page" (Application

DEFINTION) Fundamentals).

Project ID (PROJECT) PROJECT _CF See "Project Page" (Application

Fundamentals).

Scenario (BD_SCENARIO)

BUDGET SCENARIO

See "Scenario Page" (Application
Fundamentals).

Statistics Code (STATISTICS TBL)

STATISTICS_CODE

See "Statistics Code Page" (Application
Fundamentals).

Support Team Members (TEAM _
MEMBER_TABLE)

TEAM_MEMBER_TABLE_CI

See "Setting Up Customer Support
Personnel" (PeopleSoft Order to Cash
Common Information).
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Component

Component Interface

Reference

Team Member Personal Data (MEMBER
_PERSON1)

MEMBER_PERSON1_CI

See "Setting Up Customer Support
Personnel" (PeopleSoft Order to Cash
Common Information).

Team Member Types (MEMBER TYPE
_TABLE)

MEMBER_TYPE_TABLE _CI

See "Setting Up Customer Support
Personnel" (PeopleSoft Order to Cash
Common Information).

Value Added Tax Code (TAX_CODE _
VAT)

TAX_CODE_VAT

See "Value Added Tax Code
Page" (PeopleSoft Global Options and
Reports).

VAT Accounts by Business Unit (TAX
BU_CODE_VAT)

TAX_BU_CODE_VAT

See "VAT Accounts by Business Unit
Page" (PeopleSoft Global Options and
Reports).

Vat Defaults CI Component (VAT DEF
€D

VAT DEF_CI

See "Establishing VAT
Defaults" (PeopleSoft Global Options
and Reports).

VAT Entity (VAT _ENTITY_ID)

VAT ENTITY_ID

See "Setting Up VAT
Entities" (PeopleSoft Global Options and
Reports).

User Preferences (OPR_DEFAULT)

OPR_DEFAULT FIN

See "Defining Cross-Application
User Preferences" (Application
Fundamentals).

Other Sources of Information

In the implementation planning phase, take advantage of all the PeopleSoft sources of information,
including the installation guides, data models, business process maps, and troubleshooting guidelines.

See the product documentation for PeopleTools: Setup Manager and PeopleTools: Component Interfaces
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Navigating in PeopleSoft Proposal Management

PeopleSoft Proposal Management provides custom navigation center pages that contain groupings of
folders that support a specific business process, task, or user role.

Note: In addition to the PeopleSoft Proposal Management custom navigation center pages, Oracle
provides menu navigation, standard navigation pages, and PeopleSoft Navigator.

Note: The icons and features that appear on your PeopleSoft Proposal Management Home page may vary
based on user security access and roles.

Pages Used to Navigate in PeopleSoft Proposal Management

This table lists the Custom Navigation Center pages that are used to navigate in PeopleSoft Proposal
Management.

Page Name Navigation Usage

Proposal Management Center Page Proposal Management > Proposal

Management Center

Access the key areas of PeopleSoft
Financials to manage your proposals.

Click the My Proposal link on the
Proposal Management Center page.

My Proposals Page Manage proposals from a personal list.

Proposal Management Page

Click the Proposal Management link on
the Proposal Management Center page.

Create proposals, versions, and budgets.
Also inquire on existing proposals.

Resource Estimate Page

Click the Maintain Version Estimate
link on the Proposal Management Center

page.

Establish and update version project and
activity estimates.

Maintain Version Estimate Detail Page

Click the Maintain Version Est. Detail
link on the Proposal Management Center

page.

Establish and update version activity
estimate details.

Copy Proposal Page

Click the Copy Proposal link on the
Proposal Management Center page.

Copy a new proposal from an existing
proposal.
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Page Name

Navigation

Usage

Contracts Page

Click the Contracts link on the Proposal
Management Center page.

Enter and manage contracts, including
billing and revenue recognition options.

Projects Page

Click the Projects link on the Proposal
Management Center page.

Capture and account for costs and
revenue associated with a project.

Reports Page

Click the Reports link on the Proposal
Management Center page.

View and create reports.

Definitions Page

Click the Definitions link on the
Proposal Management Center page.

Define or maintain PeopleSoft Proposal
Management business units and activity

types.

See the product documentation for PeopleTools: Portal Technology
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Defining Your Operational Structure

Understanding Installation Options

When you install your PeopleSoft system, you need to set up the defaults at the overall system level and
at the application-specific level.

This section discusses:
*  Overall installation options.
e Application-specific installation options.

* Project delete utility.

Overall Installation Options

Use the pages in the Installation Options component (INSTALLATION) to configure the installation
information and to indicate how you want to use certain cross-application features. Use this component
to:

» Determine the alternate characters that the system uses for a specific language code.

» Set specific document management control options that enable the embedded document management
system and specify system-level configurations.

» Enable the use of entry events in PeopleSoft General Ledger, PeopleSoft Payables, PeopleSoft
Purchasing, and PeopleSoft Receivables.

You can find instructions for defining overall installation options in the PeopleSoft Applications
Fundamentals.

Related Links
"Setting Up Cross-Application Installation Options" (Application Fundamentals)

Application-Specific Installation Options

PeopleSoft Project Costing is the vehicle by which you process most transactions through the system,
hence you need a way to identify these transactions as they come in from the various feeder systems. Use
the Installation Options - Project Costing Integration page to identify the analysis types that are assigned
to the transactions coming into PeopleSoft Project Costing from the different feeder applications.

The system uses analysis types in downstream processing, from pricing out transactions in PeopleSoft
Project Costing to billing and revenue recognition. Therefore, you should not modify the delivered
analysis types. If you choose to modify them, remember the effects that the change may have on
downstream processing.
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Use the Installation Options - Contracts page to define installation options that are specific to PeopleSoft
Contracts. The values that you select on this page cannot be overridden on the transaction pages in
PeopleSoft Contracts. This does not apply to ad hoc products.

In addition, you can use the Installation Options - Billing - General Options page and the Installation
Options - Billing - Integration Options page to define installation options specific to PeopleSoft Billing.

You can find instructions for setting application-specific installation options in the PeopleSofi
Applications Fundamentals.

Related Links
"Setting Up Application-Specific Installation Options" (Application Fundamentals)

Project Delete Utility

In PeopleSoft Proposal Management, when a user selects another version of a proposal that has
established project and team structures in place, the system calls the Project Delete Utility from the
PeopleCode and deletes the PeopleSoft Project Costing structures under that proposal version. To activate
the Project Delete Utility for a particular business unit, you need to set up the project delete options on the
Delete Utilities Tables page in PeopleSoft Project Costing.

Setting up this page is a requirement in PeopleSoft Project Costing. To copy the existing settings of
another business unit, access the Delete Utilities Tables page, select an existing PeopleSoft Project
Costing business unit, and then click the Copy Settings button.

Setting up the Delete Utilities Tables page establishes the parameters for how the system deletes projects,
activities, and resources within a specified business unit when the system runs the Project Delete Utility.

You can find instructions for setting up the Project Delete Utility in the PeopleSoft Project Costing.

Related Links
"Delete Utility Tables Page" (PeopleSoft Project Costing)

Understanding Integration Templates

26

PeopleSoft Proposal Management integrates with PeopleSoft Project Costing, PeopleSoft Program
Management, PeopleSoft Contracts, PeopleSoft General Ledger, PeopleSoft Billing, PeopleSoft
Receivables, PeopleSoft Payables, and PeopleSoft Purchasing to deliver a full-featured solution. When
implementing PeopleSoft Financials applications, the order in which you perform the setup is important.
In most cases, you set up the PeopleSoft General Ledger system first because of the default values,
calendars, and ledger groups that the other financial applications use downstream.

Before you can make the most effective use of PeopleSoft Proposal Management, you need to establish
the basic information that the system uses in its processing. Most of the implementation procedures are
one-time sequences of data entry that provide the system with core information about the organization.

The system uses integration templates to identify the PeopleSoft General Ledger business unit with which
your projects are associated. Because transactions that are related to PeopleSoft Proposal Management are
processed through PeopleSoft Project Costing, you need to establish this relationship in the system.

Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 3

Defining Your Operational Structure

Before you can begin to track contracts and the costs that are associated with them, you must define the
integration template that the PeopleSoft Project Costing business unit will use. This template tells the
system which primary PeopleSoft General Ledger business unit will interact with the PeopleSoft Project
Costing business unit.

Note: PeopleSoft Proposal Management uses the PeopleSoft General Ledger business unit that is
designated as the Primary Ledger Business Unit on the General Ledger Integration page. Select Setup
Financials/Supply Chain > Product Related > Project Costing > Project Options > Integration
Templates > General Ledger Integration.

You can find instructions for defining integration templates in the PeopleSoft Project Costing.

Related Links
"General Integration Page" (PeopleSoft Project Costing)

Understanding Business Unit Default Setup

You must establish business units using the business unit setup pages for PeopleSoft Project Costing and
PeopleSoft Contracts before you can set up business unit defaults and confidence levels in PeopleSoft
Proposal Management. There are no fields on the PeopleSoft Contracts business unit pages that you set
up specifically for PeopleSoft Proposal Management; PeopleSoft Proposal Management uses the contract
business units as they are defined for PeopleSoft Contracts. You should set up business units and business
unit default values in this order:

1. PeopleSoft Project Costing business units.
2. Contract business units.

3. PeopleSoft Proposal Management default values for confidence levels and contract business units.

PeopleSoft Project Costing Business Units

Copyright

In PeopleSoft Project Costing, you must have at least a project business unit and integration template
set up to use PeopleSoft Proposal Management. PeopleSoft Proposal Management uses the tables in
PeopleSoft Project Costing to store information, so you must establish the business units that you plan
to use in PeopleSoft Project Costing on both the Project Costing Definition and Project Costing Options

pages.

After you set up the PeopleSoft Project Costing business units in PeopleSoft Project Costing, use the
Projects BU page in PeopleSoft Proposal Management to select the integration template and the expense
and revenue ledgers that you want to use for accounting.

Related Links
Defining PeopleSoft Proposal Management Defaults and Confidence Levels for Business Units
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PeopleSoft Contracts Business Units

You must have PeopleSoft Contracts in place before you can use PeopleSoft Proposal Management.

The business unit that you select in PeopleSoft Proposal Management when you create a proposal

comes from the Contracts Business Unit table. You establish business units that you plan to use in
PeopleSoft Contracts on both the BU Definition page and the BU Options page. After you set up the
contracts business units in PeopleSoft Contracts, use the Contracts BU Setup page in PeopleSoft Proposal
Management to establish defaults for proposal-level fields and for the Generate process.

Contracts created through Proposal Management use the Business Unit defaults set up for Separate As
Incurred Billing and Revenue and Separate Fixed Billing and Revenue in the Contract - General page in
PeopleSoft Contracts application.

Related Links
"PeopleSoft Contracts Business Processes" (PeopleSoft Contracts)
"Contract - General Page" (PeopleSoft Contracts)

Understanding Products

In PeopleSoft Contracts, a contract must have contract lines to be billed. When you initiate the Generate
process from PeopleSoft Proposal Management, the system sends data from the proposal to the
appropriate pages in PeopleSoft Contracts.

Contract lines are required because they control the processing for the billing and revenue recognition
activities. Every contract must have at least one contract line associated with it. The contract line is
connected to the contract during the Generate process. In PeopleSoft Contracts, each contract line has a
product ID defined. A product ID is a good or service that you provide to a customer.

In PeopleSoft Contracts, there is a distinction between the products that you define:
* Fixed Amount Products.

These are goods that are associated with a fixed monetary amount (for example, software,
maintenance contracts, building structures, and so on). You create these products on the Product
Definition pages and process transactions through PeopleSoft Contracts. When you set up fixed
amount products for PeopleSoft Proposal Management, select Amount as the price type on the Product
Definition - Contracts Options page, and then select a revenue method. The system ignores the other
fields on the page during the Generate process.

¢ Rate Based Products.

These are services that are associated with a rate (for example, consulting services, time and labor
expenses, and so on). PeopleSoft Project Costing controls these products, but PeopleSoft Contracts
manages the processing. When you set up rate-based products for PeopleSoft Proposal Management,
select Rate as the price type on the Product Definition - Contracts Options page, and then select a
revenue method. The system ignores the other fields on the page during the Contract Generation
process.

To bill your customers, you need to define products that represent the contract lines on your contracts.
You must define at least one product, but you may define as many products as you require.
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Note: For PeopleSoft Proposal Management, the Product Use field on the Product - Definition page
must be set to either Contracts Only or General Use. On the Proposal Management Contracts BU Setup
page, you cannot select products with product uses that are defined as General Use Excluding Contracts.
For PeopleSoft Proposal Management, the product IDs defined on the Proposal Management Contracts
BU Setup page are defaults for the activity level. They are required on the BU Setup page, but you may
override them at the activity level because contract lines bill at the activity level.

You can find instructions for defining products in the PeopleSoft Contracts documentation.

Related Links
"Setting Up Products and Product Groups" (PeopleSoft Contracts)

Defining PeopleSoft Proposal Management Defaults and
Confidence Levels for Business Units

Use these components to set up defaults for PeopleSoft Project Costing and PeopleSoft Contracts business
units:

*  Proposal Management BU Def (GM_BU PM_SETUP)

«  PM PC BU Setup (GM_PM_BU_PC)

Note: There is a dependency in the setup procedures described in this section in that you must establish
business units using the business unit setup pages for both PeopleSoft Project Costing and PeopleSoft
Contracts before you can set up defaults and confidence levels for the business units in PeopleSoft
Proposal Management.

Pages Used to Define PeopleSoft Proposal Management Defaults and
Confidence Levels for the Business Units

Page Name Definition Name Usage

Projects BU Page GM_PM _BU_PC Define proposal management defaults for
the PeopleSoft Project Costing business
unit.

Contracts BU Setup Page GM _BU PM SETUP Define proposal management defaults for

the Contracts business unit.

Confidence Level Setup Page GM_BU_CONF_SETUP Define confidence levels for the
proposals.
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Understanding PeopleSoft Proposal Management Defaults and Confidence
Levels

Because the system captures transactional data in PeopleSoft Project Costing, you must define

the PeopleSoft Project Costing business units in both PeopleSoft Project Costing and PeopleSoft
Proposal Management. The PeopleSoft Project Costing business unit setup pages provide default
values in PeopleSoft Project Costing when a user runs the Generate process from PeopleSoft Proposal
Management. It also tells the system what default ledger groups and ledgers to use to book revenue and
expense information to PeopleSoft General Ledger.

To perform the day-to-day functions of contracts management, you must also define the contracts
business unit in both PeopleSoft Contracts and PeopleSoft Proposal Management. The system uses
the default values that you established on the PeopleSoft Contracts business unit setup pages during
the Generate process in PeopleSoft Proposal Management to populate fields on the Contract pages
in PeopleSoft Contracts. The information that you define on the contracts business unit setup pages
described in this section appears by default on the Contract-General and Contract-Lines pages.

To give users a visual clue about the likelihood that a proposal will be sold, you can set up and maintain
confidence levels. You can enter percentages for three confidence levels: high, medium, and low. The
system translates the confidence levels into symbols that appear to the right of the Confidence Pct
(confidence percentage) field on the Maintain Proposal page when a user enters a value and saves the
proposal. The symbol also appears on the My Proposals page. In addition, you can use confidence levels
in your reporting and in the Proposal Operational Summary, Proposal Revenue Pipeline, and Proposal
Resource Demand pagelets.

Projects BU Page

30

Use the Projects BU page (GM_PM_BU_PC) to define proposal management defaults for the PeopleSoft
Project Costing business unit.

Navigation:

Setup Financials/Supply Chain > Business Unit Related > Proposal Management > Associate PPM
to PC BU
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This example illustrates the fields and controls on the Projects BU page. You can find definitions for the

fields and controls later on this page.

Projects BU

*Integration LS00
Ledger Group RECCORDIMNG @
Ledger |LOCAL @
*Bill & Cost Rate Plan |PM_BIL_CST
*Bill Rate Plan |PM_BIL_ONLY
*Cost Rate Plan PM_CST_ONLY

Weeks Unit of Measure MWK OJ

* Required Fields

Projects Business Unit US001 US001 NEW YORK OFPERATIONS

o

o

@, General Ledger BU US001

Other Unit of Measure |[EA  |@

]

Calendar MM ‘&,

Note: After you select an integration template, the system displays the appropriate ledger and ledger
group fields based on how you have configured your PeopleSoft General Ledger system. If you are using
PeopleSoft Commitment Control, the system displays separate ledger and ledger group fields for expense

and revenue transactions.

Ledger Group and Ledger are for non-Commitment Control General Ledger business units. Revenue
Ledger Group, Revenue Ledger, Expense Ledger Group, and Expense Ledger are for Commitment
Control General Ledger business units. In all situations, ledger fields are optional, but ledger groups fields

are required.

Field or Control

Description

Integration

Select the template that defines the integration between
PeopleSoft Project Costing and the other PeopleSoft
Financials applications. Each integration template that you
create defines a specific set of business units from the other
financial applications.

Ledger Group and Ledger

Select the ledger group and ledger that you want the system to
use when posting transactions to the general ledger from the
business unit.

Expense Ledger Group, Expense Ledger, Revenue Ledger
Group, and Revenue Ledger

These fields appear only if you are set up to use PeopleSoft
Commitment Control. Select the ledger groups and ledgers that
you want the system to default when bringing forward expense
and revenue rows that are to be posted to the general ledger.

Bill & Cost Rate Plan

Select a rate plan with billing and costing rate sets. The prompt
view for this field displays only active rate plans that contain
both billing and costing rate sets.
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Field or Control

Description

Bill Rate Plan Select a rate plan with billing rate sets only. The prompt view
for this field displays only active rate plans that contain billing
rate sets only.

Cost Rate Plan Select a rate plan with costing rate sets only. The prompt

view for this field displays only active rate plans that contain
costing rate sets.

Weeks Unit of Measure

Select MWK for the default unit of measure to use when
employees select Labor Configuration of Weeks on proposals.

PeopleSoft Proposal Management enables you to set the Labor
Configuration by hour, day, or week; however, PeopleSoft
Project Costing only supports hour or day for unit of measure.
You can set up the unit of measure for hour or day on the
Project Costing Definition page, but you need to set the unit
of measure for week on PeopleSoft Proposal Management's
Projects BU page.

Other Unit of Measure Select a unit of measure to default on proposals for non-labor
items.
Calendar This field provides an override value to the default budget

calendar that is used by Projects budgets. A budget calendar
can be defined for one budget period with a vast time span to
cover the start and end date periods for projects.

Related Links

"General Integration Page" (PeopleSoft Project Costing)

"Understanding Ledgers" (Application Fundamentals)

Contracts BU Setup Page

Use the Contracts BU Setup page (GM_BU PM_SETUP) to define proposal management defaults for the

Contracts business unit.

Navigation:

Setup Financials/Supply Chain > Business Unit Related > Proposal Management > Associate PPM

to Contract BU
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This example illustrates the fields and controls on the Contracts BU Setup page. You can find definitions

for the fields and controls later on this page.

Contracts BU Setup

Confidence Level Setup

PC Business Unit|U3001 (2,
*Contract Type | CONSULTING
*Contract Legal Entity [KBESCONSULT
*Contract Status PEMNDING
*Rate Based Product FPSL_MGMT_RATE
*Fixed Amount Product |[FFSL_MGMT_AMT
Security
O Yes
® No

* Required Fields

Business Unit US001 US001 NEW YORK OPERATIONS

*Billing BU \US001 (@,
@, *Bill Type Identifier |(CA @,

3

)

Minimum Bill Amount

i

)

@

]

e

)

Field or Control

Description

PC Business Unit (project costing business unit)

Select the PeopleSoft Project Costing business unit in which
you want to store your projects-related information.

Billing BU (billing business unit)

Select the business unit that you want to use for billing. This
field is a default for contracts that are created under this
business unit. The values that you can select are limited to
those PeopleSoft Billing business units that are linked to the
same general ledger business unit as the contracts business
unit.

Contract Type Select a value to categorize your contracts for reporting
purposes.

Bill Type Identifier Select a bill type. This field is a default for contracts that are
created under the business unit. The bill type represents a
category of activity that is being billed.

Contract Legal Entity Select a legal entity from the list of entities that you

established on the Define Legal Entity page in PeopleSoft
Contracts. This is the legal entity in your company that owns
or has signed the contract. A legal entity is required for
contract activation.

Minimum Bill Amount

Enter an amount to specify the minimum threshold that will
produce a bill during contract administration.
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Field or Control

Description

Contract Status

Select the status to appear by default when the contract is first
established. The system uses this field to control all processing
that occurs against a contract.

Rate Based Product

Select the rate-based product that you will use most often

on the contract lines. The lookup list for this field displays
only product IDs with a price type of Rate and a revenue
recognition method of As Incurred. Products are defined on the
Product Definition pages and in PeopleSoft Contracts.

Fixed Amount Product

Select the fixed-amount product offering that you will use
most often on the contract lines.

The lookup list for this field displays only products with

a price type of Amount and a revenue recognition method
other than As Incurred. Products are defined in the Product
Definition pages and in PeopleSoft Contracts.

Security

Select Yes to enable security. When security is enabled, the list
of users who can view a proposal is limited to those who have
been given security access on the Proposal - Set Up Options

page.

Related Links

"Defining Contract Types" (PeopleSoft Contracts)
"Defining Legal Entities" (PeopleSoft Contracts)
"Defining Contract Statuses" (PeopleSoft Contracts)

"Understanding PeopleSoft Billing Business Units" (PeopleSoft Billing)

Confidence Level Setup Page

Use the Confidence Level Setup page (GM_BU_ CONF_SETUP) to define confidence levels for the

proposals.

Navigation:

Setup Financials/Supply Chain > Business Unit Related > Proposal Management > Contracts

BU > Confidence Level Setup

34
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This example illustrates the fields and controls on the Confidence Level Setup page. You can find
definitions for the fields and controls later on this page.

Business Unit US001

Low Confidence

Percent From 0

Medium Confidence

Percent From 71

High Confidence

Percent From 26

Contracts B Setup Confidence Level Setup

Percent To |70 L

Percent To |25 v

Percent To 100 @

Field or Control

Description

Percent To

Enter the highest percent value to which you want to set

the confidence level for the low and medium categories.
The symbol to the right of the field appears on the Maintain
Proposal page when a user enters a value in the Confidence
Pct field and saves the proposal. It also appears on the My
Proposals page and the Proposal Operational Summary
pagelet.
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Securing Your PeopleSoft Proposal
Management System

Understanding PeopleSoft Proposal Management Security

This section discusses:
*  Multilevel security.

*  Security by department and user ID.

Multilevel Security

PeopleSoft Proposal Management uses multilevel security. Use the security setup pages in PeopleTools to
provide access to the data, functions, and pages that give users the ability to perform their work. To define
security for the organization, you must:

* Define permission lists.
*  Set up user roles.
*  Assign permission lists to roles.

PeopleSoft Proposal Management supports user security, which enables you to limit access to specific

PeopleSoft Proposal Management proposals based on the user and department. Therefore, it is possible
for a user to have access to a subset of all the proposals that may be stored in the system. This security
feature augments the normal PeopleSoft security based on the user class, which defines the menus and
components available to a given user ID.

By default, if you have not set up department-level security, users only have access to their own
proposals. That is, they can only access a proposal if these conditions are met:

*  Their user ID has an employee ID associated with it.
» They have used their employee ID to initiate the proposal.

You can associate each user ID to an employee ID (EMPLID) when you create it.

Security by Department and User ID

Implementing security within PeopleSoft Proposal Management is optional. If you want to restrict the

list of users who can view proposals, select Yes in the Security group box on the Contracts BU Setup
page. If you want all proposals under a business unit to be visible to all users, select No. When you enable
security, the list of users who can view proposals is limited to those who have been granted security
access on the Proposal - Set Up Options page.
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Establish PeopleSoft Proposal Management security by setting up a series of associations that limit or
provide user access to components. Set up these associations by linking user IDs with a security tree
node that represents a department or group of departments. When a user attempts to open a component,
the system examines the associations between that user's ID and user class. If you have established
appropriate links, the user can open the pages. Additionally, the search records for each component only
enable the user to access the records that have departments that are associated with the security tree.

Note: The pages listed in this procedure are fully documented in PeopleTools documentation.

To set up security by Department ID:

1.

Create a new role by selecting PeopleTools > Security > Permissions & Roles > Roles.

You can create as many roles as necessary. You will want to create a role for every set of users that
needs a different level of security access to the data.

Create user IDs and assign roles to user IDs by selecting PeopleTools > Security > User Profiles >
User Profiles.

Note: Be sure to assign a valid employee ID. This ID will be matched with the proposal or proposal
project to determine which proposals can be accessed by this user ID when no department-level
access is specified.

Define the PeopleSoft Proposal Management security tree by selecting Tree Manager > Tree
Manager.

Set up the security tree based on an analysis of business processes within the organization. If a
department tree already exists and mirrors a department hierarchy that would provide the appropriate
coverage for security needs, you may copy that tree.

Note: The department security tree must be a node-oriented tree. That is, each node on the tree must
represent a valid department that exists in the Department table (DEPARTMENT TBL). When you
define the detail tree structure, make sure that the node record equals the Department table and the
field equals Department ID (DEPTID).

Assign an object group to a permission list by selecting PeopleTools > Security > Permissions &
Roles > Permission Lists.

Define operator security by selecting Set Up Financials/Supply Chain > Security >Setup Proposal
Mgmt Security

Select the tree SetID, tree name, and the effective date of tree. In the lower section of the page, select
the department designation and access code. You can enter as many departments as you need.

Change the search records for PeopleSoft Proposal Management components by selecting
PeopleTools > Application Designer > File > Open > Components.

The search record that is delivered for these proposal components provides department-level security.
Currently, the search records that are defined below are delivered with the system. You may replace
these security search records if you require a different security scheme.

This table lists the menu navigations, components, and search records used in PeopleSoft Proposal
Management:
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Menu Navigation

Component

Search Record

Proposal Management, Proposal and
Version, Maintain Proposal

GM_OPPTY HDR

GM_OPTY_SRCH VW

Proposal Management, Proposal and
Version, Maintain Version Estimate

GM_OPPTY_PRICT

GM_OPVR_SRCH VW

Proposal Management, Proposal and
Version, Maintain Version Est. Detail

GM_PM RSRC DTL

GM_PM_ACTV_RSRC

Proposal Management, Proposal and
Version, Copy Proposal

GM_BUD PPSL_CPY

GM_PROP_SRCH
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Structuring PeopleSoft Proposal
Management

Understanding PeopleSoft Proposal Management Structure

This section discusses:
* Customer information.
* Proposal contacts.
* Project roles and rates.

* Proposal planners.

Customer Information

To add customers to the database, enter the required information in the General Information component
(CUSTOMER_GENERAL). To enter new customer information using the least number of fields,
access the pages in the Quick Customer Create component. You can also use Quick Customer Create to
determine whether a customer exists in the system.

To initiate a number-sequencing scheme, access the Auto Numbering page and set the automatic
numbering options.

Related Links

"Defining Additional Common Information" (Application Fundamentals)
"Using Quick Customer Create Functionality" (PeopleSoft Order to Cash Common Information)
"Auto Numbering Page" (Application Fundamentals)

Proposal Contacts

Proposal contacts are members of support teams. Support team members are the personnel in your
organization who are involved in customer support and managing support teams.

To add proposal contacts to PeopleSoft Proposal Management, you must set up each team member as
a sales person in the Team Member Personal Data component (MEMBER PERSONT1). You can then
assemble members into teams and associate teams with customers, quotes, and sales orders.

Related Links

"Using Quick Customer Create Functionality" (PeopleSoft Order to Cash Common Information)
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Project Roles and Rates

In PeopleSoft Project Costing, you can define and assign rates by role. Additionally, you can establish
distinct rates by region. Role rates include the setup of both the rate that you bill the client and the costs
for providing the person who is assigned to the role. You can use these rates on the Maintain Version
Estimate Detail page in PeopleSoft Proposal Management to price and cost proposals.

You can change the role rates for specific activities on projects in a proposal. By changing a role rate on
the Maintain Version Estimate Detail page, you change the role rate for all occurrences of that role on
the activity. The same role can have different custom rates for different activities on a project in the same
proposal.

Before you can create and use role rates, you must first define security profiles and project roles in
PeopleSoft Project Costing.

Proposal Planners

Typically, you bring human resource information into PeopleSoft Financials from a human resources
system. You do not usually have to add new employees or assign them employee IDs. However, you can
add new employee records on the Personal Data (Edit) page (EX PERSONAL DATA?2) using the Setup
Financials/Supply Chain > Common Definitions > Employee Data > Create/Update Personal Data
navigation.

Warning! Any data that you enter or modify on the Personal Data (Edit) page is not reflected in the
human resources system and is subject to override.

Related Links

"Defining Additional Common Information" (Application Fundamentals)

Defining PeopleSoft Proposal Management Control Data

This section discusses how to define control data.

Pages Used to Define PeopleSoft Proposal Management Control Data

Page Name Definition Name Usage
Activities Page GM_ACTIVITY_PM Create activity ID templates. Entering

values on this page provides the prompts
for the Activity field on the Proposal
Time Estimate page.

Budget Items Page PC_BUD_ITEMS Create budget items. Entering values
on this page provides the prompts for
the Budget Item field on the Maintain
Version Estimate Detail page.
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Page Name Definition Name Usage

Proposal Key Words Page GM_PROP CTR KEY Create key words. Entering values on
this page provides the prompts for the
Key Word field on the KeyWords page.

Activities Page
Use the Activities page (GM_ACTIVITY_PM) to create activity ID templates.

Entering values on this page provides the prompts for the Activity field on the Proposal Time Estimate
page.

Navigation:

Set Up Financials/Supply Chain > Product Related > Proposal Management >Setup PPM Activity
Type

This example illustrates the fields and controls on the Activities page. You can find definitions for the
fields and controls later on this page.

Activities
SetlD SHARE Activity ID COMNSULTATION
Detail
*Effective Date |01/01/1300 i *Status | Active 3 [+ (=]
Short Description Consult

*Description |Consultation

Activities are tasks associated with a project. Activity ID templates are labels that identify and group
activities to facilitate analysis and reporting about similar activities across all projects. The activities
that you enter on this page are available for selection on the Resource Estimate page in PeopleSoft
Proposal Management. To add activities to the system, select an effective date and status, and then enter
descriptions for each activity.

Budget Items Page
Use the Budget Items page (PC_BUD ITEMS) to create budget items.

Entering values on this page provides the prompts for the Budget Item field on the Maintain Version
Estimate Detail page.

Navigation:

Set Up Financials/Supply Chain > Product Related > Project Costing > General Options >Setup
PC Budget Items
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This example illustrates the fields and controls on the
fields and controls later on this page.

Chapter 5

Budget Items page. You can find definitions for the

Budget Iltems

SetlD SHARE

Budget ltem SALARY Description Time for Proposal Management

Budget ltems

General Project Information General Ledger Information

*Effective Date *Effective Status *Description

01/01/1900 @ Active | |Time for Proposal Management

Personalize | Find | View All |ﬁ| | = First '@ 1 of 1 &/ Last

Unit of

Resource Class
Measure

Billing Business Unit

v [ @, % @, # =]

Budget items provide a way of identifying and grouping transactions; you use them to review an activity's
budget costs or revenue for a given period. The system makes the budget items that you enter here
available in the Budget Item field on the Maintain Version Estimate Detail page in PeopleSoft Proposal

Management.

Budget Items - General Tab

Field or Control

Description

Resource Class

Select a resource class to associate with the budget item.
Options are:

*  Labor: A human resource, with or without an employee
ID, that can be associated with activities.

*  Material: A consumable resource. For example,

computers and office supplies are material resources.

*  Asset: A non-human resource. For example, equipment

and facilities are asset resources.

. Other: A resource class to capture subcontractor expenses
and expense type expenses such as travel, lodging, and
meals.

Description

Enter a description for each budget item that you are creating.

Unit of Measure

Select, if applicable, unit of measure, such as MHR (hours),
MDY (days), MWK (week), and EA (each), to enforce
continuity across a budget.

Billing Business Unit

Enter a business unit if you want to segregate budget amounts
by billing business units.

Budget Items - Project Information Tab

Use the fields in this tab to associate fields in PeopleS

oft Project Costing with the budget item.
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Budget Items - General Ledger Information Tab

Use the fields in this tab to associate ChartFields in PeopleSoft General Ledger with the budget item.

Proposal Key Words Page
Use the Proposal Key Words page (GM_PROP _CTR _KEY) to create key words.
Entering values on this page provides the prompts for the Key Word field on the KeyWords page.
Navigation:

Set Up Financials/Supply Chain > Product Related > Proposal Management >Setup PPM
Proposal Key Words

This example illustrates the fields and controls on the Proposal Key Words page.

Proposal Key Words

Setld SHARE Keyword IMSLLIM
Key Word Detail Find | View All First'4' 10f1 *' Last
*Effective Date 01/01/1900 Eﬂ *Ctatus | Active w ﬂﬂ

*Description |Insulin

Use key words to track proposals by subject category and for analysis and reporting. You can associate
multiple key words with a proposal. The key words that you enter on this page are available for selection
on the Key Words page in PeopleSoft Proposal Management. To add key words to the system, select an
effective date and status, and then enter a description for the key word.

Note: You can also add key words from the Resource Estimate page in PeopleSoft Proposal Management.
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Understanding the Proposal Preparation Process

PeopleSoft Proposal Management enables you to develop and administer project proposals to expedite the
closure of business opportunities and to reuse proposal versions for future engagements.

This diagram shows the hierarchy of a proposal. Proposals are the highest level of the hierarchy, and
can contain multiple versions, which can contain multiple projects that can be associated with multiple
activities that are assigned one or more resources.

Proposal

Yersions

Projects

Activities

Resource Types (Labor,
Asset, Material, Other

Using PeopleSoft Proposal Management:

* A proposal can have multiple versions.

* A version can have multiple projects.

* A project can have multiple activities.

* Each project must have at least one activity.

* An Activity can have multiple resources.

To prepare and generate proposal information using PeopleSoft Proposal Management:
» Enter general proposal information.

Proposal preparation begins on the Maintain Proposal page, where you enter or select a start and end
date, customer, proposal planner, proposal contact, proposal description, and version description. This
information does not usually change throughout the process of creating various proposal versions.

*  Configure the system to calculate labor.
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You can use the business calendar that you identified at the project level; however, users decide how
to estimate their labor at the proposal level. You can estimate labor by hour, start and end dates, or
weeks. (The number of hours in a week is driven by the business holiday calendar.)

If you estimate labor by hours, the total will be Hourly Rate x Hours.

If you estimate labor by start date and end date, the system uses the business calendar to determine the
working hours between the dates.

If you estimate labor by weeks, the total will be Hours Per Week x Number of Weeks x Hourly Rate.

On the Time Configuration page, you can configure PeopleSoft Proposal Management to calculate
time based on your specific business practices. For example, if you configure PeopleSoft Proposal
Management to calculate 10-hour days and you have an hourly rate of 20.00 USD, then the system
multiplies the hourly rate by 10 for each estimated day of work. You can also display time information
in weeks or use the start and end dates that you entered on the proposal to calculate time estimates.

Enter security and billing information.

Provided that you have enabled security when you set up your business units, you can limit the
number of people who are able to view your proposal by selecting specific departments and
employees on the Setup Options page. You can also use this page to tell the system what types of
rows to create (bill, cost, both, or none) when you generate contract and budget information from the
proposal.

Enter labor estimates.

You can enter a resource (labor, asset, material, other (subcontract)) estimate for each project and
activity that is associated with the proposal. For each project role that is associated with an activity,
you can enter the number of people on the project who will be assigned to the role and the estimated
number of hours. The system displays the unit cost and bill rates for each resource and then calculates
the estimated cost and bill amounts as well as margin percentages for the proposal on the Summary
page. On the Cost tab on the Maintain Version Estimate Detail page, you can enter adjustments to the
bill rate as a flat amount, a percentage, or a new rate. Time and Expense to Resource are combined.

Add attachments and key words.

To add information that you can't enter on any of the pages included in the proposal preparation
process, you can upload files from your computer or server to the Attachments page that is associated
with the proposal. For reporting purposes, you can categorize your proposals by key word by selecting
a descriptive word or phrase from the Key Words page.

Enter adjustments.

After entering all labor and non-labor information for the particular version of the proposal, you can
make adjustments to both the overall labor and the overall non-labor totals on the Maintain Proposal
page by entering either a positive or negative percentage.

Enter new proposal versions.

After you finish creating an initial proposal and version, you can create different versions of the same
proposal by adding a row in the Version group box on the Maintain Proposal page. As you enter

new labor and non-labor information, the system calculates the totals for the particular version of the
proposal and summarizes the information on the Maintain Proposal page. This feature is useful when
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you want to compare time and expense estimates for different versions of the same proposal. Only one
version, however, can be submitted for the Contract Generation process.

e Generate contracts.

After the customer accepts a version of the proposal, you can change the status of the proposal
to Committed and then generate data that PeopleSoft Contracts, PeopleSoft Project Costing, and
PeopleSoft Billing use to create invoices and track project-related information.

Understanding Project Teams

This section discusses:
* Project Teams.

* Project Delete Utility.

Project Teams

PeopleSoft Project Costing uses project teams to identify and manage the resources that are needed to
complete an assignment. In PeopleSoft Proposal Management, you can initiate the creation of a project
resource team for the selected version of a proposal by selecting the Create Resources Team check box
on the Maintain Version Estimate Detail page.

Using the Project Team Summary page in PeopleSoft Project Costing, you can create and modify a
project's resource requirements, assign employees directly to a team, and view its current members. You
can further define project teams into separate activity teams that can include employees and resource
requirements. If you installed Resource Management, then you can also initiate service orders to staff
open positions.

If a user selects another proposal version after the project team is created, the system displays a warning
message that it will delete any existing project team structures. In this case, the project and the project
activity structures are also deleted.

Note: If a user edits the project team structures in PeopleSoft Project Costing after the system creates
the project team, the system does not write data back to the Maintain Version Estimate Detail page

in PeopleSoft Proposal Management. If you run the Pre-Spending or Contract Generation process, it

is not possible to change versions and delete existing projects. This is important as you don't want to
orphan projects and activities with transactional activity. You cannot use a project in a pending status for
transactional activity, so it is okay to delete these project teams.

Project Delete Utility

To delete unused project team structures, PeopleSoft Project Costing uses an application engine program
called the Project Delete Utility. If project and project team structures are set up for the selected version
of a proposal, and a user selects another version of the proposal, the system deletes all of the PeopleSoft
Project Costing structures under the prior proposal version. The system initiates the deletion of the
project structures (including the project team structures) by calling the Project Delete Utility from the
PeopleCode.
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To make the Project Delete Utility operable, you need to set up the project delete options on the
Delete Utility Tables page during the setup of your PeopleSoft Project Costing business units. This is
a PeopleSoft Project Costing requirement. The Delete Utility Tables page essentially stores all of the
projects tables that you want deleted when you run the Project Delete Utility.

Related Links
"Delete Utility Tables Page" (PeopleSoft Project Costing)

Understanding the Generate Process

This section discusses:

*  Pre-spending.

e The Generate process.

» Contract general information.
* Contract lines.

* PeopleSoft Billing plans.

* Revenue recognition plans.

* Projects and activities.

* Rate templates.

* Budget generation.

Pre-Spending

Sometimes you need to enable spending before a proposal is formally approved. When you initiate the
Pre-Spending process from the Maintain Proposal page, the system creates the selected projects (in a
pending status) and the associated activities in PeopleSoft Project Costing. It does not create a contract
or bring forward the budget at this time. The process does store the contract ID and project ID with the
proposal to reserve them until you are ready to initiate the Generate process.

When you run the Generate process, the system creates the contract, brings forward the budgets, and
includes projects and activities that you added since you ran the Pre-Spending process. After you run the
Generate process in PeopleSoft Proposal Management for a proposal, you cannot run it again.

The Generate Process
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When the proposal status changes to Committed, you can run the Generate process to create the contract
and project structures. After you run the Generate process, the system automatically updates the Generate
status of the proposal to Generated on the Maintain Proposal page in PeopleSoft Proposal Management
and creates the following based on information from the proposal and on the default values for the
contracts business unit:

» Contract general information.
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* Contract lines.

* PeopleSoft Billing plans.

* Revenue recognition plans.

* Projects and activities.

* Resource lines (asset, material, labor, and other).
* Rate sets.

After the system creates the contract and the contract lines, you cannot run the Contract Generation
process again for the proposal. The system stores the contract and project IDs that you created in
PeopleSoft Contracts and PeopleSoft Project Costing with the proposal in the appropriate tables.

Contract General Information

Defining a contract header is the first step in setting up a new contract. The Generate process in
PeopleSoft Proposal Management fills in the appropriate fields based on the defaults that you set up for
the contracts business unit and on information contained in the proposal.

Contract fields are available for editing until you activate the contract. Then all fields, except for the
Contract Status field, become display-only. Any changes to the Contract Entry components must be
made through amendment processing.

Before activating a contract, look at the fields on the page to verify that it is the correct contract. Change
the contract status to Active. A processing status of Active indicates that all data for the contract is entered
into the system, and that the contract has passed system data validation. A contract must have a status of
Active for any contract element to be available for processing. Contracts with an Active status have these
attributes:

» Data fields are available for entry only through amendment processing.

* Downstream processing is enabled for the contract.

* The system has confirmed entry of the required fields and has validated contract data.
» The contract is included in prompt pages.

* Contract amendment control is active for the contract.

Related Links

"Defining General Contract Information" (PeopleSoft Contracts)

Contract Lines

A contract line corresponds to an individual product or service. The Generate process in PeopleSoft
Proposal Management fills in the appropriate fields based on the defaults that you set up for the contracts
business unit and on information contained in the proposal.

A contract line corresponds to an individual product or service. For PeopleSoft Proposal Management
contracts, a product is a service that you define on the Product Definition page. The system uses the
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information from the Contract General page and the product to create a set of default values for the
contract line. You can override much of this default information at the line level and add additional
details. For service-related contract lines, you can associate the contract line with additional projects and
rates.

Related Links
"Defining Contract Lines" (PeopleSoft Contracts)

Billing Plans

Billing plans store information about when billing occurs, how bills should appear, and what notes should
relate to the bill. Data from PeopleSoft Contracts drives the creation of bill lines for fixed-price contract
lines. For rate-based contract lines, data from both PeopleSoft Contracts and PeopleSoft Project Costing
drives the creation of bill lines. In both cases, PeopleSoft Contracts creates the bill lines for the Billing
Interface tables (PS_INTFC_BI, PS_INTFC _BI2, PS_ INTFC _NOTE, PS_INTFC BI_AEDS, and

PS INTFC_BI _HDR).

The Generate process in PeopleSoft Proposal Management fills in the appropriate fields on the Billing
Plan General page in PeopleSoft Contracts based on the default values that you set up for the PeopleSoft
Proposal Management business unit and associated bill and bill detail templates on the products assigned
to activities.

When you change the contract status to Active, the system automatically changes the status of the billing
plan to Ready. At this point, you can initiate the Contracts Billing Engine process to select the billing plan
for processing. To transfer bill lines to PeopleSoft Billing, you must run the Contracts/Billing Interface
process (CA_BI INTFC).

Note: The system creates billing plans only if a billing plan template is assigned to the product ID used on
the contract line.

Related Links

"Understanding Billing in Contracts" (PeopleSoft Contracts)

"Understanding the Contracts Billing Process" (PeopleSoft Contracts)

"Establishing Product Definitions" (PeopleSoft Order to Cash Common Information)

Revenue Recognition Plans
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Revenue recognition plans lists events that define when revenue is recognized for each contract line that
is linked to that revenue recognition plan. You associate events with either percentages or amounts. The
percentage or amount reflects how much of the contract line's negotiated amount is recognized upon a
certain date, milestone, or user-initiated action.

The Generate process in PeopleSoft Proposal Management fills in the appropriate fields on the Rev Rec
Plan (revenue recognition plan) page in PeopleSoft Contracts based on the defaults that you set up for the
PeopleSoft Contracts business unit and on information contained in the proposal. When you change the
contract status to Active, the system automatically changes the status of the revenue recognition plan to
Ready.

Data from PeopleSoft Contracts drives the creation of accounting entries for fixed-amount contract lines.
For rate-based contract lines, data from PeopleSoft Contracts and PeopleSoft Project Costing drives the
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creation of accounting entries. In both cases, PeopleSoft Contracts creates accounting entries to send to
PeopleSoft General Ledger and creates the bill lines that the system sends to PeopleSoft Billing.

PeopleSoft Contracts generates the revenue entries, crediting revenue and debiting contract asset, and
then sends these entries to PeopleSoft General Ledger. PeopleSoft Billing generates the offsetting entries,
crediting contract asset and debiting PeopleSoft Receivables.

Note: The system creates revenue recognition plans only if a revenue plan template is assigned to the
product ID used on the contract line.

Related Links
"Establishing Product Definitions" (PeopleSoft Order to Cash Common Information)
"Understanding Revenue Plans" (PeopleSoft Contracts)

Projects and Activities

The Generate process creates projects and activities in PeopleSoft Project Costing based on information
that is contained in the proposal. If the system cannot create the required structures, then the Generate
process cannot be completed.

To verify that the project and activities exist, navigate to the Related Projects page from the Details tab
on the Lines page in PeopleSoft Contracts. You can also navigate to the Project General page through the
PeopleSoft Project Costing navigational structure.

After you create projects and activities through the Generate process, you can maintain project
information, perform project analysis, track procurement costs, create budgets, track expenses, gather
resource costs, price resources, process allocations, and generate operational reports.

Related Links
"Understanding Projects" (PeopleSoft Project Costing)
"Understanding Activities" (PeopleSoft Project Costing)

Rate Sets

You charge customers a rate for the services that you provide plus the related costs. By establishing rate
sets and rate plans in PeopleSoft Project Costing, you can efficiently manage pricing across multiple
project activities using a limited number of rate plans. Rate sets and rate plans in PeopleSoft Project
Costing are dynamic and subject to change in rate structure over time.

When you sell a service to a customer, you establish rates for that service. The service can be provided at
your standard billing rates, which may be subject to change over time, or you might provide services at
rates that are fixed for the duration of the contract obligation.

For details about using the rate plan and defining rate sets for rate-based contract lines, refer to the
PeopleSoft Contracts documentation.

Related Links

"Understanding the Relationship Between PeopleSoft Contracts and PeopleSoft Project
Costing" (PeopleSoft Contracts)

Copyright © 1988, 2022, Oracle and/or its affiliates. 53



Understanding the Proposal Process Chapter 6

"Understanding Integration with PeopleSoft Contracts and PeopleSoft Billing" (PeopleSoft Project
Costing)

Budget Generation

When you run the Generate process, the system creates in PeopleSoft Program Management's ARL the
project team and activity resource team information along with bill and cost rates. Resource lines with
markup or markdown appear in the ARL as custom rate type lines.

The Generate process then creates revenue and cost budget plans. In doing this, the Generate process
calls the Get Plan Application Engine process (PGM_SPREAD) to spread the budget detail based on the
defined calendar and any markup or markdown amounts appear as single rows per resource line on the
Budget Detail page. For example, if there two bill rows and a 10 percent markup, the system creates one
line for each resource row as follows:

Line Number Row Type Results
Line 1 Resource row 11,600 USD
Line 2 10% markup of resource row 1 1,160 USD
Line 3 Resource row 40, 000 USD
Line 4 10% markup of resource row 2 4,000 USD

For more information on the Get Plan process, refer to PeopleSoft Project Costing's budgeting process.
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Preparing and Generating Proposal Information

This section discusses how to prepare and generate proposal information.

Page Used to Prepare and Generate Proposal Information

Page Name Definition Name Usage

Maintain Proposal Page GM_OPPTY_HDR

Enter general proposal information.

Maintain Proposal Page

Use the Maintain Proposal page (GM_OPPTY_ HDR) to enter general proposal information.
Navigation:

Proposal Management, Proposal Management Center, Proposal Management, Maintain Proposal
*  Proposal Management > Proposal and Version > Maintain Proposal

This example illustrates the fields and controls on the Maintain Proposal page. You can find definitions
for the fields and controls later on this page.

Maintain Proposal
Proposal CONDOOO00000025 *Status| 01 - Draft A
*Description Implementation senices quote Confidence Pct 90
P I ! @ *Currency USD
*Customer Alliance Group Q *Start Date 03/01/2005 |5 *End Date [02/28/2006  |[3
Proposal Contact Angelini,Gina @, Proposal Due Date 02/15/2005 [
Proposal Planner Miller,William Q
Generate Status Mot Generated IR RO (I
falESnEnding Process Monitor
Comments
Version Personalize | Find | \'—l First'4' 1-3 of 3 "1/ Last
Overall Summary Labor Summary MNon-labor Summary
Copy Proposed L=tz ] L=tz Nonlabor Margin
Version Description . I’.’ Cost Amount Bill Amount P . Adjustment Adjustment Margin Harg .
Version Amount N . N Percent
Percent Percent Percent
® w101 Oracle Implementatior] [F=] 153,298.80  240798.80  240798.80 38.68 [+] [=]
O w2 Cracle Implementation % 73,149.90 119,649.90 113,674.90 -5.00 3570 ﬂ j
O V103 Oracle Implementatian By 216,298.80 34429880  309,898.80 -10.00 [+ =
Go To Labkor Configuration Set Up Options
* Required Fields
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Note: For proposals that you initiated from PeopleSoft Customer Relationship Management (CRM), the
Status field on this page is view-only. The system displays the Ready button when the proposal is in
Draft status. Click this button to change the proposal status to Ready and launch an enterprise integration
point (EIP) that updates the status in PeopleSoft CRM. All other status changes are prompted by an EIP.

Field or Control Description

Proposal This is a display-only field. When you add a new proposal, the
system displays NEXT. This automatically generates a system-
assigned ID when you save the proposal. The system-assigned
ID is derived from the Contracts table and remains the same
throughout the Contract Generation process so that both the
proposal and the contract in PeopleSoft Contracts have the
same ID.

After you run the Generate process, the system turns this
field into a link that enables you to access the contract on the
Contract - General page in PeopleSoft Contracts.

Status Select a value to specify the state of the proposal. Options are:

*  Draft: Select when you are in the process of developing
the proposal. This status appears by default when you
first access this page. You can initiate the Pre-Spending
process in this status if you have created one or more
projects for the proposal.

*  Ready: Select if you are ready to submit the proposal. You
can initiate the Pre-Spending process in this status if you
have created one or more projects for the proposal.

*  Committed: Select if the proposal was accepted. At this
point you cannot edit the proposal further. You can initiate
the Pre-Spending or Contract Generation processes. You
can change the status to Committed only if the proposal is
in Ready status.

Note: You cannot commit a proposal if the proposed
amount is equal to zero.

*  Denied: Select if the proposal has been denied. You can
change the status to Denied only if the proposal is in the
Ready status.

*  Canceled: Select to cancel the proposal. You can change
the status to Canceled only if the proposal is in Draft or
Ready status.
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Field or Control

Description

Confidence Pct (confidence percentage)

Enter a number between 1 and 100 to reflect your level of
confidence that the proposal will be approved. The proposal
planner usually enters or provides this number. The system
translates the number that you enter here into a color-coded
icon that represents the confidence level as either high,
medium, or low.

You determine confidence levels on the Contracts Business
Unit - Confidence Level Setup page. The colored icon next to
this field indicates the confidence level of this proposal.

Indicates a low confidence level.

]

Indicates a medium confidence level.

(o]

Indicates a high confidence level.

Currency Select the currency to use in financial transactions if the
proposal results in a contract. This code defaults from the
Currency Code field that you selected on the Contracts BU
Definition page during implementation.

Customer Select the customer for whom you are creating the proposal.

Start Date and End Date Select the estimated start and end dates of the project that you

are proposing.

Proposal Contact

Select the person who is the contact for the proposal.

Proposal Due

Select the date on which the proposal is due for completion by
the proposal planner. This date must be less than the proposal
target date.

Proposal Planner

Select the name of the person who is drafting or planning the
proposal.
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Field or Control

Description

Generate Status

Displays a status based on the processes that you have run,
either Pre-Spending or Contract Generation. Values are:

*  Not Generated.
*  Pre-Spending: Only the selected version is editable.

If you initiated the Pre-Spending process when the
proposal was in the Draft or Ready status, you can add
new projects and activities. You cannot delete existing
projects and activities, although you can add or delete
detail lines. You cannot select a different version of the
proposal from the one that you selected for the Pre-
Spending process, as the system has already created the
projects and activities in PeopleSoft Project Costing for
the selected version and has also established contract and
project IDs.

If you are going to generate a contract from the proposal,
then you must use the version of the proposal that was
selected when you initiated Pre-Spending.

If you initiated the Pre-Spending process when the
proposal was in Committed status, you cannot edit the
proposal. To generate a contract, you must use the version
of the proposal that was selected when you initiated Pre-
Spending.

*  Contract Generated: The system has generated proposal
information into tables in PeopleSoft Project Costing and
PeopleSoft Contracts. The proposal must contain one or
more projects before you can generate a contract, and the
proposal must be in Committed status.

Add to My Proposals

Click to add the proposal to the My Proposal page.

See Using the My Proposals Page.

Pre-Spending

Click to initiate the Pre-Spending process. The Pre-Spending
process creates the selected projects in PeopleSoft Project
Costing with a project status of Approved and a processing
status of Active. The system also creates the corresponding
activities. The system also displays a green check mark next
to the version that you selected for pre-spending. The Pre-
Spending process does not create a contract or generate any
budget lines.

When you run the Generate process, the system creates the
contract and adds new activities with the appropriate dollar
amounts.

Note: The Pre-Spending process creates Project IDs and
activities; it does not generate any budget lines or any contract
entities.
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Field or Control

Description

Generate

Click to generate a contract from the information that is
entered on the proposal for the selected version. The system
creates projects in PeopleSoft Project Costing based on the
information that you enter on the Resource Estimate and
Maintain Version Estimate Detail pages. The system also
displays a green check mark next to the version that you
selected for pre-spending.

Comments

Field or Control

Description

Type Select the type of comment that you want to enter. Options
are: Assumptions, Deliverables, Dependencies, Goals, Notes,
Objectives, Purpose, or Risks. You can add each comment type
only once.

Description Enter the text of your comment. To add another comment, add
a new row.

Version: Overall Summary Tab
Field or Control Description

Version

Displays the versions associated with the proposal. You can
select only one version for approval and eventually generate it

into a contract.

Click the version link to access the Resource Estimate page to
view, add, or modify project information.

Click the Copy Version Information to New Version button
to access the Copy Version page and copy the information to a
new proposal version within the same proposal.

Cost Amount, Bill Amount, and Proposed Amount

Displays the total cost, total billing amount, and total amount
that you propose to charge for both labor and non-labor for the
proposal version, after adjustments.
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Field or Control

Description

Labor Adjustment Percent

Displays the percent amount that you entered in the
Adjustment Percent field on the Labor Summary tab for
overall time adjustments. This number applies to all activities
that are included in the proposal version for labor detail lines

only. It can be either a positive or a negative percentage.

Nonlabor Adjustment Percent

Displays the percent amount that you entered in the
Adjustment Percent field on the Non-labor Summary tab
for overall expense adjustments. This number applies to all
activities that are included in the proposal version for non-
labor detail lines only. It can be either a positive or a negative
percentage.

Labor Margin Percent

Displays as a percentage the difference between the proposed
amount and the cost amount for labor (Proposed Amount —

Cost Amount) +~ Proposed Amount.

Nonlabor Margin Percent

Displays as a percentage the difference between the proposed
amount and the cost amount for non-labor expenses (Proposed

Amount — Cost Amount) +~ Proposed Amount.

Version: Labor Summary Tab

Field or Control

Description

Adjustment Percent

Enter the percent (either positive or negative) by which to
make an overall adjustment to the proposed amount for labor.
The number that you enter here applies to all activities in the
proposal version for labor detail lines only.

Margin Percent

Displays as a percentage the difference between the proposed
amount and the cost amount for labor (Proposed Amount —
Cost Amount) +~ Proposed Amount.
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Version: Non-labor Summary Tab

Field or Control Description

Adjustment Percent Enter the percent (either positive or negative) by which to
make an overall adjustment to the proposed amount for non-
labor expenses. The number that you enter here applies to all
activities in the proposal version for non-labor detail lines
only.

Margin Percent Displays as a percentage the difference between the proposed
amount and the cost amount for non-labor expenses (Proposed

Amount — Cost Amount) +~ Proposed Amount.

Configuring Labor Defaults, Bill Options, and Security

This section discusses how to configure proposal labor defaults and set up proposal bill options and
security.

Pages Used to Configure Labor Defaults, Bill Options, and Security

Page Name Definition Name Usage

Labor Configuration Page GM_OPPTY_HDR HRS Enter activity time.

Set Up Options Page GM_OPPTY_HDR SEC View customer contact information,
set security options, and select billing
options.

Labor Configuration Page
Use the Labor Configuration page (GM_OPPTY_ HDR_ HRS) to enter activity time.
Navigation:
Proposal Management > Proposal and Version > Maintain Proposal

Click the Labor Configuration link on the Maintain Proposal page.
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This example illustrates the fields and controls on the Labor Configuration page. You can find definitions
for the fields and controls later on this page.

Labor Configuration

Set Activity Time As Hours

Ok Cancel
Field or Control Description
Set Activity Time As Select a value to specify how to calculate time on the proposal.

The value that you select here appears as the column heading
on the Units tab on the Maintain Version Estimate Detail page.

*  Hours
o Weeks

e Start/End Date

Note: PeopleSoft Proposal Management does not enable you
to change the value in this field if you have already created
budget detail lines for the activities on the proposal.

Set Up Options Page

Use the Set Up Options page (GM_OPPTY HDR SEC) to view customer contact information, set
security options, and select billing options.

Navigation:
Proposal Management > Proposal and Version > Maintain Proposal.

Click the Set Up Options link on the Maintain Proposal page
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This example illustrates the fields and controls on the Set Up Options page. You can find definitions for

the fields and controls later on this page.

Set Up Options
Proposal Target | 03/01/2005 [51]
Customer Contact Estimate Bill Options
Contact Name Paula Smith Create Budget Options
Address 14410 Union Ave (& Bill and Cost Rows
San Jose CA 95124 O Bill Rows
Telephone 88/967-2253 O Cost Rows
Email psmith@genericemnail.com O hone
e Create Rate Options
By Departrment )
@ Bill and Cost Rows
Department @, ) Bill Rows
By Individual O Cost Rows
i Personalize | Find IE| ||:| First'4' 1 of 1
Employee .
Last
Employee Hame
1 @, [+l [=]
Field or Control Description
Proposal Target Select the estimated approval date. This date must be greater
than current date.

Customer Contact

Displays name, address, telephone, email, and information for the contact person at the customer site. The
data displayed in this section is customer sold-to information.

Estimate Bill Options

When you initiate the Generate process, the system brings forward each item entered on the Maintain
Version Estimate Detail page into the Budget Detail page in PeopleSoft Project Costing. The items appear

in the budgets grid as distinct lines.

The system also generates cost and bill rows for each labor and non-labor detail. Additionally, the system
groups all of the cost and bill rows together within the budgets grid.

To control the type of information that the system creates during the Contract Generation process, select

the values that correspond to your business needs.
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Field or Control

Description

Create Budget Options

Select a value to specify the types of budget transactions that
you want the system to create in PeopleSoft Project Costing
when you run the Contract Generation process from the

Maintain Proposal page. Options are:
*  Bill and Cost Rows

*  Bill Rows

*  Cost Rows

*  None

Create Rate Options

Select a value to specify the types of rate set target rows that
you want to create for the rate set that the system will use for
billing in Contracts. Options are:

*  Bill and Cost Rows
e Bill Rows

e Cost Rows

Security

To enable security you must first select Yes in the Security group box on the Contracts BU Setup page.
When you select Yes, the list of users who can view a proposal includes only those to whom you have

given security access to use the fields.

The system uses both the Department and the Employee Name fields as security filters.

Field or Control

Description

Department

Use this field to limit access to the proposal by department.
The system gives everyone in the department view access to
the proposal.

Employee Name

Use this field to limit access to the proposal by employee. To
add multiple employees, click the Add button.

Entering Resource Estimates

This section discusses how to create labor and resource estimate, make adjustments to the bill rate,
create expense estimates, enter project control details, add attachments and keywords, and view time and

expense summary information.
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Pages Used to Enter Labor and Non-Labor Estimates

Page Name

Definition Name

Usage

Maintain Proposal Page

GM_OPPTY_HDR

Enter general proposal information.

Resource Estimate Page

GM_PM_RSRC _EST

Create or modify project and activity
information. You can also view the total
bill and cost amounts by activity.

Maintain Version Estimate Detail Page

GM_OPPTY DTL

Enter resource information.

Bill Estimate - Resource Note Page

GM_SCEN_LINE NOTE

View or modify information about the
resource line.

Current Bill Rate Page

GM_ADJUSTB_SECPNL

Make adjustments to the billing rate.

Project Control Page

GM_OPPTY_PRICT _CTL

Displays high-level project information.
You can change the PeopleSoft Project
Costing business unit, type, and manager.

Attachments Page

GM_OPPTY DOCI

Add documents to the proposal.

Keywords Page

GM_OPPTY_KEYWORD

Add keywords to the proposal.

Summary Page

GM_OPPTY _SUMMARY

View time and expense information at
the project, activity, and overall time and
expense levels.

Resource Estimate Page

Copyright

Use the Resource Estimate page (GM_PM_RSRC _EST) to create or modify project and activity

information.

You can also view the total bill and cost amounts by activity.

Navigation:

Click the Version link on the Maintain Proposal page.
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This example illustrates the fields and controls on the Resource Estimate page. You can find definitions
for the fields and controls later on this page.

Resource Estimate Summary

Proposal COMO00000000025
Version V101
Project Information
Project 000000000000160
Total Cost 153,298.80
Activity Summary
Activity

Description

COMSULTATION |Consultation on scope

Return to Maintain Proposal

Implementation services quote

Description Oracle Implementation

Description |Implementation

Total Bill

Total Cost

153,298.80

. Margin S
Total Bill Percent Activity
249,798.50 38.63 B [+ [=]

Currency USD

Find First 4/ 1 of 1 &/ Last

[+ [=]

24979880 Copy Project Project Control

Personalize | Find | &2 | E First'*' 1 of1 '®/ Last

Go To Attachments and Keywords

Project Information

Field or Control

Description

Project

Display-only. If you are adding a new project, the system
displays NEXT. This automatically generates a system-
assigned ID when you save the proposal version. This ID

is derived from the Projects table and remains the same
throughout the generation process. Upon generation, both
the Proposal ID and the Project ID remain in sync with the
Contract and Project IDs.

After you run the Contract Generation or the Pre-Spending
process, the system turns this field into a link that you can
click to access the Project General page in PeopleSoft Project
Costing.

Copy Project

Click to access the Copy Project page. The system makes this
field display only after you initiate the Contract Generation
process.

Note: You can copy projects within a proposal after you run
the Pre-Spending process. If the proposal is in a Committed
status, however, the system locks down the proposal and you
can no longer add projects.

See Understanding the Copy Functionality in PeopleSoft
Proposal Management.
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Field or Control

Description

Project Control

Click to access the Project Control page, which contains
PeopleSoft Project Costing related fields that the system uses
in the project creation process.

See Project Control Page.

Activity Summary

Field or Control

Description

Activity

Select an activity type to add to the project that you are
creating. You can select an activity type from the list or
enter a new one (which does not appear in the prompt list).
Activity cannot be NEXT. If the activity is not listed, enter

a description for the activity in the field. After you run the
Contract Generation or the Pre-Spending process, the system
turns this field into a link that you can click to access the

activity in PeopleSoft Project Costing.

Description

Enter text to describe the activity that you are adding to the
project.

Total Cost

Displays the total cost contained in the project across all
activities.

Total Bill

Displays the total bill amount contained in the project across
all activities.

Margin Percent

Displays as a percentage the difference between the total bill
and the total cost for activities (Total Bill — Total Cost) + Total
Cost.

Attachments and Keywords

Click to access the Attachments and Keywords pages.

Maintain Version Estimate Detail Page

Use the Maintain Version Estimate Detail page (GM_OPPTY DTL) to enter resource information.

Navigation:

Click the Activity button in the Activity Summary grid on the Resource Estimate page.
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This example illustrates the fields and controls on the Maintain Version Estimate Detail page. You can
find definitions for the fields and controls later on this page.

Maintain Version Estimate Detail

Proposal CONO00000000025
Version V101

Project 000000000000160

Activity CONSULTATION

Return to Maintain Version Estimate

Total Cost 153,288.80
*Viewr Classes}) | Al |
Resources
Resources | Units || Cost
ge:sc;ur:e Assetor ltem Resource Name
Labor
Labor
Asset ITZ105 @, Compag Armada K700
Material 10005 Q, Refrigerator, Inside Heat Exch

Description Implementation services quote

Description Oracle Implementation
Description Implementation
Description | Consultation on scope

*Product |PPSL_MGMT_RATE @,

Total Bill

Currency USD

[create Resources Team

Region

Code Project Role

@, [PROJMANAGER |@

@, [FUNC ANALYST |@,

249798.80

Calculate Totals

Personalize | Find | &2 | E First ‘& 1-4 of 4 &' Last

Resource Pool Budget Item MHotes

Unassigned Pog@, [SALARY e B [+] [=]
Unassigned Pog@, [SALARY e = [+] [=]
Unassigned Pool ECQUIP @ B [+ =]
Unassigned Pool SLPL @, B [+ [=]

Field or Control

Description

Project

Click to access the General Information page.

Pricing Method

Select a value to specify the way in which the system prices
the activity. When you run the Generate process, the system
passes this information to PeopleSoft Contracts.

After you initiate the Pre-Spending or Generate process, this
field is display-only.

As Incurred: The as-incurred method is transaction-
based. This is the only method that is used for rate-based
contract lines. As Incurred applies to the contract line and
to both revenue recognition and billing.

Fixed: Select to use a fixed-amount contract line for a
product or service for which you charge a fixed amount.
Fixed-amount contract lines have a price type of Amount
or Percent. For fixed-amount contract lines, you associate
the contract line with a revenue recognition plan that has a
revenue recognition method of Apportionment, Milestone,
or Percent Complete. Fixed applies to the contract line
and to both revenue recognition and billing.
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Field or Control

Description

Product

The entry in this field appears by default from the Contracts
BU Setup page and is based on the value you select for the
Pricing Method field. If you select a new value in the Pricing
Method field, the entry in this field changes accordingly.

You define products on the Product Definition pages and in
PeopleSoft Contracts. The product you select here is used for
billing purposes in PeopleSoft Contracts after your run the
Contract Generation process.

See Understanding Products.

Total Cost

Displays the total cost contained in the project for the activity.

Total Bill

Displays the total bill amount contained in the project for the
activity.

Calculate Totals

Click to refresh the Total Cost and Total Bill amounts prior to
saving the estimate. The system also updates Total Cost and
Total Bill amounts when you save.

View Class(es)

Select to view specific Resource Classes on the Resources
tab.

Create Resources Team

Select to have the system create a project team on the

pages in the Project Team component in PeopleSoft Project
Costing. When you save the proposal, the system creates the
information in PeopleSoft Project Costing.

Resources - Resources Tab

Field or Control

Description

Resource Class

Select a resource class. Options are 4sset, Labor, Material, and
Other.

Asset or Item

Select an asset or item if you selected Asset or Material

resource class.

Resource Name

Enter the person's name or text to describe the team member
whom you are adding to the activity. When you create the
resources team, the system concatenates the value in the
Resource Name field with a system-generated sequence

number.
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Field or Control

Description

Project Role

Select the role of the person who will work on the activity
that you are creating. Project roles are tied to cost and bill
rates. When you select a project role, the system automatically
fills in the Unit Cost Rate and Unit Bill Rate fields on the
Resources - Cost tab.

Note: If the Project Role is set up in the project pricing
structure, the system fills in the Unit Cost Rate and Unit Bill
Rate fields. If rate is not set up, the system displays a warning

message.

Budget Item

Select to identify a budget item with the resource class.

Click the Notes button to access the Resource Note page.

Resources - Units Tab

Field or Control

Description

Start Date Displays the start date that you entered in the Start Date field
on the Maintain Proposal page. You can change the start date
here for the project role, but it cannot be greater than the end
date.

End Date Displays the end date that you entered in the End Date field on

the Maintain Proposal page. You can change the end date here
for the project role, but it cannot be less than the start date.

Unit of Measure

Select a unit of measure.

Hours

Enter the number of hours for the labor resource class row.

Resources - Cost Tab

Field or Control

Description

QTY (quantity)

Enter the number of people who will work on the activity who
will have the role that you selected.
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Field or Control

Description

Unit Cost Rate Display-only. Indicates the per-hour rate that you are paying
the people assigned to the project role.

Unit Bill Rate Display-only. Indicates the per hour rate that you are billing
the customer for the people assigned to the project role.

Actual Bill Rate Display-only. Indicates the Unit Bill Rate plus or minus any
adjustments made on the Current Bill Rate page.

Adjust Click to access the Bill Estimate - Current Bill Rate page. You

can use this page to make adjustments to the bill rate as a flat

amount, as a percentage, or as a new rate.

Note: All rates must be greater than zero after the adjustment
is made. A rate can not be negative number.

See Current Bill Rate Page.

Bill Estimate - Resource Note Page

Use the Bill Estimate - Resource Note page (GM_SCEN_LINE NOTE) to view or modify information

about the resource line.

Navigation:

Click the Notes button in the Resources grid on the Maintain Version Estimate Detail page.

This example illustrates the fields and controls on the Bill Estimate - Resource Note page.

Resource MNote

Activity CONSULTATION

Resource Class Labar

Comments

Gl Cancel

Description Consultation on scope

Resource Hame Budget Item SALARY
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Current Bill Rate Page
Use the Current Bill Rate page (GM_ADJUSTB_SECPNL) to make adjustments to the billing rate.
Navigation:

Click the Adjust Current Limit Bill Rate button in the Resources - Cost grid on the Maintain Version
Estimate Detail page.

This example illustrates the fields and controls on the Bill Estimate - Current Bill Rate. You can find
definitions for the fields and controls later on this page.

Current Bill Rate

Unit Bill Rate 310.00
Adjust Bill Rate 310.00
Adjust Bill Rate
O Flat Amount 0.00
O Percentage 0.00
C New Rate 0.00

® No Adjustment

@'Apply Rate to all Resource lines with same Region/Project Role

O Apply Rate to current Resource line

O Cancel

Field or Control Description

Unit Bill Rate Displays the rate that you are billing for the person who is
assigned to the project role.

Adjust Bill Rate Displays the new rate based on the adjustments you made.

Flat Amount Enter the number by which to adjust the rate, either a positive
or a negative number. When you click OK and then save the
page, the system adjusts the rate by the number that you enter.
(Adjustment Bill Rate = Bill Rate + Flat Amount)

Percentage Enter the percentage by which you want to adjust the rate,
either a positive or a negative number. When you click OK
and then save the page, the system adjusts the rate by the
number that you enter. Adjustment Bill Rate = Bill Rate *
( 100 + Percentage )/100
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Field or Control

Description

New Rate

Enter the number that you want the system to use to calculate
the proposed bill amount for the people who are assigned to
the project role. You can only enter a positive number. When
you click OK and then save the page, the system changes the
rate to the number that you enter. Adjustment Bill Rate = New
Rate

No Adjustment

Select this option if you want the system to use the original
rate when it calculates the proposed bill amount for the project
role.

Apply Rate to all Resource lines with same Region/Project
Role

Select this option if you want to apply this rate to all the
resource lines with the same region and project role in the
current activity.

Apply Rate to current Resource line

Select this option if you want to apply the rate only to the
current resource row.

Project Control Page

Use the Project Control page (GM_OPPTY PRIJCT CTL) to displays high-level project information.

You can change the PeopleSoft Project Costing business unit, type, and manager.

Navigation:

Proposal Management > Proposal and Version > Maintain Version Estimate

Click the Project Control link on the Resource Estimate page.

Copyright © 1988, 2022, Oracle and/or its affiliates.

73



Preparing, Generating, and Viewing Proposal Information

Chapter 7

This example illustrates the fields and controls on the Project Control page. You can find definitions for

the fields and controls later on this page.

Project Control

Proposal COMO00000000025
Version Y101
Project 000000000000160
Detail

PC Business Unit LS001
Project Type |SALES @, sales

B

Project Manager [Miller,William

Project Calendar 01

Hours Per Day 300 MHR

Hours Per Week MHR

Return to Maintain Version Estimate

Cracle Implementation

Implementation

5001 NEW YORK OPERATIONS

Standard Business Calendar

L

B

Note: When you initially enter proposal information, the link to this page is not available until you enter
information in the Time Estimate and Expense Estimate pages, save the pages, and then return to the Time

Estimate page from the Maintain Proposal page.

Detail

Field or Control

Description

PC Business Unit (project costing business unit)

Displays the PeopleSoft Project Costing business unit that you
selected when you set up the PC business unit. To control the
project using another PeopleSoft Project Costing business unit,
select a new one. The value in the PC Business Unit field
cannot be changed if you have created detail lines for Time or
Expense, or when the project team has been created.

Note: You cannot change the PC Business Unit after the
system creates a project team, after you initiate Pre-Spending,
or after you change the proposal to the Committed status.

Project Type

Select the type of project that you are adding to the proposal.
You set up project types in PeopleSoft Project Costing.

Project Manager

Select the name of the person who is the manager of the
project.
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Use the Attachments page (GM_OPPTY_ DOCT1) to add documents to the proposal.

Navigation:

Click the Attachments and Keywords link on the Resource Estimate page.

Field or Control

Description

Click the Add Attachment icon to add a document to the
proposal. Click Browse to locate the document on your system
and then click Upload to attach the document to the proposal
and return to the Attachments page.

=

Click the Delete Attachment button to delete an attached
document.

|

Click the View Attachment button to display the contents of
the attached document.

Return to Maintain Version Estimate

Click to return to the Resource Estimate page.

Keywords Page

Use the Keywords page (GM_OPPTY_ KEYWORD) to add keywords to the proposal.

Navigation:

Click the Attachments and Keywords link on the Resource Estimate page; then click the Keywords tab.

This example illustrates the fields and controls on the Keywords page. You can find definitions for the

fields and controls later on this page.

Attachments Keywords
Proposal CORMNOO0D00000025 Implementation services quote

Version V101 Oracle Implementation

Key Word Detail Personalize | Find | 2 | E First'4' 1 of 1'% Last

‘Keywords Description
1 @, [+] [=]

Return to Maintain Version Estimate
Field or Control Description
Keyword Select the word that you want to associate with the proposal.
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Field or Control

Description

Click the Add Keyword button to access the Proposal Key
Words page to enter new words that you can then associate
with proposals.

Return to Maintain Version Estimate

Click to return to Resource Estimate page.

Summary Page

76

Use the Summary page (GM_OPPTY SUMMARY) to view time and expense information at the project,

activity, and overall time and expense

Navigation:

levels.

Proposal Management > Proposal and Version > Maintain Version Estimate > Summary

This example illustrates the fields and controls on the Summary page (1 of 2). You can find definitions for
the fields and controls later on this page.

Resource Estimate Summary
Proposal COMN000000000025 Implementation services quote
Version V101 Oracle Implementation
*Summary By | Proposal v
Total Cost Amount 153,298.80
Total Bill Amount 249,798.80
Total Adjustment Amount 0.00
Total Proposed Amount 249,798 80
Detail
Project ID Activity ID g?ﬂz:'“e Resource Hame Project Role ﬁ;:?“ aty
. PROJ .
1000000000000160  CONSULTATION Labar MANAGER SALARY 1
2000000000000160 COMSULTATION  Labor Az SALARY 1
= . ANALYST iy
o . . Compag
3000000000000160 COMSULTATION  Asset Armada M700 EQUIP 1
. . Refrigerator,
4 000000000000160  COMNSULTATION Material Inside Heat Exch SUPL 100

Currency USD
StartDate 032/01/2005

End Date 02/28/2006

Labor Overall Margin 3868 %

Nonlabor Overall Margin 000 %

Personalize | Find | 2 | [ First ‘&) 1-4 of 4 &/ Last

Hours CostRate Cost oy pate  Bill Amount Margin Percent
Amount

500  180.00 90,000.00 31000  156,000.00 4194

450 140.00  §3,000.00 210.00 94,500.00 3333

1.00 1.00 1.00 1.00 0.00

298 29780 298 297 80 000

This example illustrates the fields and controls on the Summary page (2 of 2). You can find definitions for
the fields and controls later on this page.

Labor Cost Amount

Labor Bill Amount

Labor Adjustment Amount
Labor Proposed Amount
Nonlabor Cost Amount
Honlabor Bill Amount
Nonlabor Adjustment Amount

Nonlabor Proposed Amount

Return To Maintain Proposal

153,000.00

249,500.00

0.00

249,500.00

29880

20880

0.00
208.80

Labor Adjustment Percent 0.00 %
Labor Overall Margin 38.68 %
Nonlabor Adjustment Percent 000 %
Nonlabor Overall Margin 000 %

This page summarizes detailed and overall resource information by activity and by project.
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Field or Control Description

Summary By Select a value to change the way that the system displays time
and expense information. Options are:

e Activity.
*  Project.
*  Proposal.

Using the My Proposals Page

This section discusses how to use the My Proposal page.

Pages Used to View, Add, and Remove Proposals

Page Name Definition Name Usage
My Proposals Page GM_MY PROPOSAL View proposal information on the My

Proposals page.

Add/Remove from My Proposals Page GM_MYOPP_ADD Add proposals to and remove them from
the My Proposals list.

My Proposals Page

Use the My Proposals page (GM_MY PROPOSAL) to view proposal information on the My Proposals
page.

Navigation:

Proposal Management > My Proposals
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This example illustrates the fields and controls on the My Proposals page. You can find definitions for the
fields and controls later on this page.

My Proposals
Smith,Jane
Current Proposals Personalize | Find | view anl | 21 | EE First ‘4’ 1 of 1 ‘& Last
Proposal Description Status Con;i:::r;crﬁ Alert Proposal Target
= Proposal
Create Mew Proposal
Version
Version Description Currency Prgﬁ%ﬁ?ﬂi Cost Amount Time Owerall Margin
Y101
Edit List
Field or Control Description

_ Click the View All related Version Data button to display
version information for the proposal.
Proposal Click to access the Maintain Proposal page to view that
proposal.
Alert Displays a red square, yellow triangle, or green diamond to

indicate the alert level.

Create New Proposal

Click to access the Maintain Proposal page to add a new
proposal.

Version Click to access the Resource Estimate page that is associated
with the proposal.
Edit List Click to access the Add/Remove from My Proposals page.

Use the Add/Remove from My Proposals page (GM_MYOPP_ADD) to add proposals to and remove

them from the My Proposals list.

Navigation:

Proposal Management > My Proposals.

Click the Edit List link on the My Proposals page.
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This example illustrates the fields and controls on the Add/Remove from My Proposals page. You can
find definitions for the fields and controls later on this page.

Add/Remove from My Proposals
Smith,Jane
Enter criteria for finding Proposals. A "% can be used in the Proposal description to indicate any value.
Proposal Description
Customer
Proposal Contact
Search Clear Criteria
Proposal List Personalize | Find | view All | | B First @) 12072 ) Last
Select Proposal 1D Title Customer Proposal Contact
il CONO00000000025 Implementation services quote Alliance Group Angelini,Gina
il CONODD0000000029 Implementation services quote Alliance Group Angelini,Gina
Save
Field or Control Description
Proposal Description, Customer, and Proposal Contact Enter or select information to search for proposals. To find
proposals using a partial value, enter the percent sign as a
wildcard in the Proposal Description field.
For example, to find all proposals beginning with
Implementation, enter %6Implementation. This search function
is case sensitive.
Select Select to add proposals to the My Proposals page. To remove
proposals, deselect this check box.

Viewing CRM-Related Information

This section discusses how to view CRM-related information.

Page Used to View CRM-Related Information

Page Name Definition Name Usage
Additional Information for CRM Page GM_OPPTY_HDR_CRM View CRM-related information for the
proposal.
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Additional Information for CRM Page
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Use the Additional Information for CRM page (GM_OPPTY_HDR_ CRM) to view CRM-related
information for the proposal.

Navigation:
Proposal Management > Proposal and Version > Maintain Proposal
Click the Additional Information link on the Maintain Proposal page.

If you created a proposal from PeopleSoft CRM, you can view customer contact information and CRM-
related data on this page. To access the order in PeopleSoft CRM, click the link next to the Capture ID
field.

Note: The interface to your PeopleSoft Customer Relationship Management database is dependent on

a URL identifier that is delivered called CRM_INTERFACE. If you are having trouble accessing your
PeopleSoft Customer Relationship Management database, check the entry in the URL field on the URL
Maintenance page under the PeopleTools menu navigation structure (select PeopleTools > Utilities >
Administration > URLs.)
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Understanding the Copy Functionality in PeopleSoft Proposal
Management

In PeopleSoft Proposal Management, you use the Copy Proposal Process component
(GM_BUD_PPSL_CPY) to copy proposals, versions, and projects. Use the:

* Copy Proposal feature to copy versions to use in different proposals.

When you copy a new proposal from an existing proposal version, the system generates the new
proposal, version, and project IDs. The system does not select the Create Resources Team check box
when you initiate the Copy Proposal feature.

»  Copy Version feature to copy versions to use in the same proposal.

When you copy a version, the system generates a new version ID. The system uses the same proposal
ID as the proposal version from which you are copying to prevent conflicting data when it generates
the proposal into a contract.

*  Copy Project feature to copy projects to use in the same version.

When you copy a project, the new proposal ID and version ID match the proposal and version from
which you are copying. The system generates the new project ID. Like the Copy Proposal and Copy
Version pages, you can select activities and copy options on the Copy Project page. The system uses
the same proposal ID as the project from which you are copying to prevent conflicting data when it

generates the proposal into a contract.

Copying Proposal Information

This section discusses how to copy proposal information.

Page Used to Copy Proposal Information

Page Name Definition Name Usage
Copy Proposal Page GM_BUD_ PPSL CPY Copy proposal information to a new
proposal.

Copy Proposal Page

Use the Copy Proposal page (GM_BUD PPSL CPY) to copy proposal information to a new proposal.
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*  Proposal Management, Proposal Management Center, Copy Proposal

* Proposal Management > Proposal and Version > Copy Proposal

This example illustrates the fields and controls on the Copy Proposal page. You can find definitions for

the fields and controls later on this page.

Copy Proposal
From Proposal CONO000000000025
From Version ID V101
From Start Date 03/01/2005

From End Date 02/28/2006

Project

From Project ID 000000000000160 Implementation

Activity

*To Proposal |

*To Version

To Start Date |02/01/2005 |[H

To End Date 02/28/2006
Find | View Al First'4' 1 0f1 & Last

To Project ID

Personalize | Find | G | [ First'&' 1 of 1 &/ Last

Copy From Activity To Activity *Copy Options
CONSULTATION CONSULTATION @, | Labor and Non-labor A
Copy
Field or Control Description

To Proposal

The word NEXT appears by default. When you click Copy, the
system generates the next proposal ID that is available.

To Version

The word NEXT appears by default. When you click Copy, the
system generates V'/(1as the version ID.

To Start Date and To End Date

By default, the system populates the start and end dates of

the proposal from which you are copying; however, you can
change these values. If you change the start and end dates on
the target proposal, the copy process changes the start and end
dates for all of its projects and activities.

Project

Field or Control

Description

From Project ID

Deselect this check box for all the projects that you do not
want to copy to the new proposal.

To Project ID

The word NEXT appears by default. When you click Copy,
the system copies project and activity information to the next
available project ID.
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Activity

Field or Control Description

From Activity Deselect this check box for all the activities that you do not
want to copy to the new proposal.

To Activity The activity ID of the version from which you are copying
appears by default. You can, however, select a new activity ID
from the list of available choices.

Copy Options Select a value to specify which information you want to copy
to the proposal for the particular activity: Labor and Non-
labor (system default), Labor, Non-labor, or None.

Copy Click to initiate the copy process.

Copying Proposal Versions

This section discusses how to copy proposal versions.

Page Used to Copy Proposal Versions

Page Name Definition Name Usage
Copy Version Page GM_BUD_PPSL CPY Copy version information within the

same proposal.

Copy Version Page

Use the Copy Version page (GM_BUD_ PPSL._CPY) to copy version information within the same
proposal.

Navigation:

* Proposal Management > Proposal Management Center > Proposal Management > Maintain
Proposal

Click the Copy Version button on the Maintain Proposal page.
* Proposal Management > Proposal and Version > Maintain Proposal

Click the Copy Version button on the Maintain Proposal page.
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This example illustrates the fields and controls on the Copy Version page. You can find definitions for the
fields and controls later on this page.

Copy Version
From Proposal CON000000000025 *To Proposal |
From Version 1D V101 “To Version
From Start Date 03/01/2005 To Start Date
From End Date 02/28/2008 To End Date 02/28/2008
Project Find | View All First'&' 1 of 1 &/ Last
From Project ID 000000000000160 Implementation To Project D
Activity Personalize | Find | 0 | [E First' ' 1of 1 °®' Last
Copy From Activity To Activity *Copy Options
CONSULTATION CONSULTATION @, [Labor and Non-labor v
Copy

Field or Control Description

To Proposal Displays the current proposal ID from which you are copying
the proposal version. You cannot change this field. The new
version of the proposal must have the same proposal ID.

To Version Displays the word NEXT. When you click Copy, the system
generates the next available version ID for the proposal. For
example, if the proposal has versions V101, V102, and V103
and you are copying version V101, the system automatically
labels the new version V104.

To Start Date and To End Date The system populates the start and end dates of the version
from which you are copying. You cannot modify these fields.

Project

Field or Control Description

From Project ID The system automatically selects all projects when you enter
this page. Deselect this check box for all the projects that you
do not want to copy to the new version of the proposal.

To Project ID Displays the ID of the project from which you are copying
information. You cannot change the number in this field. The
new project ID must always equal the copied project ID, so
that there are no conflicting data issues when the proposal is
generated into a contract.
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Activity

Field or Control Description

From Activity Select this check box for all the activities that you want to
copy to the new version of the proposal.

To Activity The activity ID of the version from which you are copying
appears by default. You can, however, select a new activity ID
from the list of available choices.

Copy Options Select a value to specify which information you want to copy
to the new version for the particular activity: Labor and Non-
labor (system default), Labor, Non-labor, or None.

Copy Click to initiate the copy process.

Copying Projects

This section discusses how to copy projects.

Page Used to Copy Projects

Page Name Definition Name Usage
Copy Project Page GM_BUD_PPSL CPY Copy project information within the

same proposal.

Copy Project Page

Use the Copy Project page (GM_BUD_PPSL CPY) to copy project information within the same

proposal.

Navigation:

* Proposal Management, Proposal Management Center, Proposal Management, Maintain Proposal

Click the Version link on the Maintain Proposal page, and then click the Copy Project link on the

Resource Estimate page.

* Proposal Management > Proposal and Version > Maintain Proposal

Click the Version link on the Maintain Proposal page, and then click the Copy Project link on the

Resource Estimate page.
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This example illustrates the fields and controls on the Copy Project page. You can find definitions for the
fields and controls later on this page.

Copy Project
From Proposal COMO000000000025 *To Proposal |
From Version 1D V101 *ToVersion[/101
From Start Date 03/01/2005 To Start Date [02/01/2005

From End Date 02/258/2006 To End Date 02/28/2006

Project Find | view Al First'*' 10f 1'% Last

To Project ID

From Project ID 000000000000160 Implementation

Activity Personalize | Find | 22 | [ First '+ 10f 1*' Last
Copy From Activity To Activity *Copy Options
CONSULTATION CONSULTATION @, | Labor and Non-labor v

86

Copy

Field or Control

Description

To Proposal

Displays the current proposal ID from which you are copying
the project. You cannot change these fields. The new project
must have the same proposal ID. To copy information from an
entire proposal or a version, use the Copy Proposal page or the
Copy Version page.

To Version

Displays the current version ID from which you are copying
the project. You cannot change these fields. The new project
must have the same version ID.

To Start Date and To End Date

The system populates the start and end dates of the project
from which you are copying. You cannot change these fields.

Project

Field or Control

Description

From Project ID

Indicates the value of the source project.

To Project ID

Displays the word NEXT. You cannot change the information
in this field. When you click Copy, the system generates the
next available project ID.
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Activity

Field or Control Description

From Activity Select this check box for all the activities that you want to
copy to the new project. The system automatically selects all
activities when you first access this page.

To Activity The activity ID of the project from which you are copying
appears by default. You can, however, select a new activity ID
from the list of available choices.

Copy Options Select a value to specify which information you want to copy
to the new project for the particular activity: Labor and Non-
labor (system default), Labor, Non-labor, or None.

Copy Click to initiate the copy process.
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Generating PeopleSoft Proposal
Management Reports

Understanding Proposal Reports

PeopleSoft Proposal Management provides three types of reports that summarize proposal information:
* Proposal reports.

Managers use these reports to determine whether to pursue an opportunity.
e Revenue pipeline reports.

Managers use these reports to review the revenue that is expected to be generated by proposals over a
period of time.

* Resource demand reports.

Managers use these reports to assess the resources (people) that are needed for upcoming proposals.

Generating Proposal Reports

This section discusses how to generate proposal reports.

Page Used to Generate Proposal Reports

Page Name Definition Name Usage

Proposal Reports Page RUN_GM_PROP RPT Review proposed time and expenses for
a particular proposal.

Proposal Reports Page

Use the Proposal Reports page (RUN_GM_PROP_RPT) to review proposed time and expenses for a
particular proposal.

Navigation:

Proposal Management > Reports > Proposal Reports
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This example illustrates the fields and controls on the Proposal Reports page.

Proposal Reports

Run Control ID prop_rpt

Language | English W

Report Request Parameters

*WVersion 1D [V101 @, Oracle Implementation

Report Manager

*Business Unit\U3001  |@,  US001 NEW YORK OPERATIONS

*Proposal ID | COMN000000000025 @, Implementation services quote

Process Monitar Run

To generate the proposal reports, select a business unit, proposal, and version. Click Run. Click Process
Monitor. Select the reports that you want to run from the Process Scheduler Request page and then click

OK. You can run these reports from this page:
e Fixed Fee
* Fixed Fee Itemized

¢ Internal

Generating Pipeline Reports

This section discusses how to generate pipeline reports.

Page Used to Generate Pipeline Reports

Page Name Definition Name

Usage

Revenue Pipeline Reports Page RUN_GM_PL RPT

Review the expected revenue for a
particular time period according to
specified criteria.

Revenue Pipeline Reports Page

Use the Revenue Pipeline Reports page (RUN_GM_PL_ RPT) to review the expected revenue for a

particular time period according to specified criteria.

Navigation:

Proposal Management > Reports > Revenue Pipeline Report

90
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This example illustrates the fields and controls on the Revenue Pipeline Reports page.

Revenue Pipeline Reports

Run Control ID rev_pipe

Language | English w

Report Request Parameters

*Business Unit |LI=001

Proposal Status | 1. Draft

Confidence

*Proposal Target Due Date

Report Manager

o

Customer Alliance Group

Proposal Contact [Angelini,Gina

FProcess Monitar Run

@, US001 NEW YORK OPERATIONS
w

To 100

el e

*To

To generate the revenue pipeline reports, select a business unit, proposal status, confidence level,
customer, proposal contact, and proposal target due dates. Click Run. Click Process Monitor. Select the
reports that you want to run from the Process Scheduler Request page and then click OK. You can run

these reports from this page:

* By Confidence Report in Tenths.
* By Confidence Rpt in Quartile.

* By Customer Name Report.

* By Status Report.

Generating Labor Resource Reports

This section discusses how to generate resource reports.

Page Used to Generate Labor Resource Reports

Page Name

Definition Name

Usage

Resource Demand Report Page

RUN_GM_RES_RPT

Analyze the demand on labor resources
for future months according to project
role.

Resource Demand Report Page

Use the Resource Demand Report page (RUN_GM_RES RPT) to analyze the demand on labor resources

for future months according to project role.
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Navigation:

Proposal Management > Reports > Resource Demand Report

This example illustrates the fields and controls on the Resource Demand Report page.

Resource Demand Report

Run Control ID res_demand Report Manager Process Monitar Run
Language | English W

Report Request Parameters

*Business Unit | US001 @,

Proposal Status | Ready w
*Confidence Th *To 100
*Resource Schedule Start Date IEJ *To E"J

To generate the resource demand report, select a business unit, proposal status, confidence level, and
resource schedule start and end dates. Click Run. Click Process Monitor. Select the labor Resource
Demand by Project Role report from the Process Scheduler Request page and then click OK.

Retrieving Proposal Information

This section discusses how to review and retrieve proposal information.

Page Used to Retrieve Proposal Information

Page Name Definition Name Usage

Proposal Inquiry Page GM_PROPOSAL_INQ

Retrieve proposal information.

Proposal Inquiry Page

Use the Proposal Inquiry page (GM_PROPOSAL INQ) to retrieve proposal information.

Navigation:

Proposal Management > Interactive Reports > Proposal Inquiry
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Generating PeopleSoft Proposal Management Reports

This example illustrates the fields and controls on the Proposal Inquiry page. You can find definitions for

the fields and controls later on this page.

Proposal Inquiry

Search Criteria

Business Unit (U500 @, Start Date
Customer ID @, End Date
Proposal Planner @, Due Date
Status | 01 - Draft v
Retrieve Clear
Proposal List
Proposal Info Mare Infa
Proposal ID Proposal Title
1 CONDOD0000000025 % Oracle Implementation

Customer

Alliance Group

Personalize | Find | View Al | 2 | First'd 1 or1 &/ Last

Proposal Planner Status

Miller, William 01 - Draft

Select the business unit, customer ID, and status of the proposals that you want to view. Click Retrieve to
get a list of proposals that match the criteria that you entered. Click the More Info tab to view begin and

end dates for the proposal.

Field or Control

Description

Click the Proposal Link button to access the Maintain
Proposal page.
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Administering Projects

Understanding How Projects are Used in PeopleSoft Proposal
Management

This section discusses:

*  Project control.

e Transaction flow control.
* Project analysis.

» Transaction review.

* Analysis inquiries.

*  Project data deletion.

Project Control

A project in PeopleSoft Proposal Management represents all or a portion of a proposal. Every proposal
in the PeopleSoft Proposal Management system requires a minimum of one project. The proposal project
automatic numbering is the same as for PeopleSoft Project Costing, which ensures continuity when the
proposal project is generated into a real project.

Note: PeopleSoft Proposal Management enables you to save a proposal without creating a project.
However, if you don't add at least one project to the proposal, you cannot run the Generate process or
the Pre-Spending process in PeopleSoft Proposal Management and automatically create projects in
PeopleSoft Project Costing.

Each project requires a minimum of one activity. Proposals can have multiple projects, and projects
can have multiple activities. To enter a transaction line into the Project Resource transaction table
(PROJ_RESOURCE) in PeopleSoft Project Costing, a project and activity must exist.

In PeopleSoft Proposal Management, you create projects when you run the Generate, Pre-Spending, or
Create Resource processes. In PeopleSoft Project Costing, you can add a project manually through the
project definition pages. However, you should only add projects manually after you have run the Generate
process. Within PeopleSoft Project Costing you can also attach a project to a contract and a contract line
within the Project Definition pages.

Related Links
"Understanding Projects" (PeopleSoft Project Costing)
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Transaction Flow Control

There are two basic ways to control the flow of data coming into PeopleSoft Project Costing:
1. Set a project or activity to Inactive status.

In this case, the project and activity do not appear in the prompt lists of the PeopleSoft feeder systems.
2. Use status control options.

On the Status Types page, select the analysis types that each feeder system uses; then select a project
control action to associate with the analysis type.

Note: No project control action occurs if the Project Control Action box is deselected.

Values include:
*  Warning: Displays a warning before the system accepts the transaction.

*  Reject: Rejects the transaction.

Instructions on controlling incoming transactions appear in the PeopleSoft Project Costing.

Related Links

"Controlling Incoming Transactions" (PeopleSoft Project Costing)

Project Analysis

96

PeopleSoft Project Costing provides several different ways to analyze project data. Before you can
analyze project data, you must:

* Create at least one project.
* Create project activities.
* Create transactions that have been assigned resource IDs.

After you establish a project and enter data directly though interfaces with other PeopleSoft applications,
you can use the pages in PeopleSoft Project Costing to:

* View a list of all project manager projects.
» Display real-time project information that is pulled from the project summary tables.
* Display all resource transactions for a selected project.

The system automatically populates the lines and analysis types that display in the Project Analysis pages.
When you post lines in the Project Budget pages to PeopleSoft Project Costing, the system adds BUD
(budget) lines to the Project Analysis pages. After you run the Integrate Enterprise Data processes, you
can use the Project Analysis pages to make inquiries on the data that originated from PeopleSoft General
Ledger, PeopleSoft Inventory, PeopleSoft Payables, PeopleSoft Purchasing, and PeopleSoft Time and
Labor.
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Instructions on analyzing project data appear in the PeopleSoft Project Costing.

Transaction Review

PeopleSoft Project Costing provides a series of pages that enable you to review costs for a project and
an activity based on different integration criteria. From these pages, you can navigate back to the related
PeopleSoft application and view transactions in greater detail.

Instructions on reviewing project costs and transactions appear in the PeopleSoft Project Costing.

Related Links
"Viewing Transactions in Progress" (PeopleSoft Project Costing)
Analysis Inquiries
PeopleSoft Project Costing provides a series of pages that you can use for online project analysis—to
view a financial or resource summary of a project, the projected costs to complete a project, under and

over budget resources, and budget to actual variances.

Instructions on performing online project analysis appear in the PeopleSoft Project Costing.

Related Links
"Analyzing Projects Using Analysis Inquiries" (PeopleSoft Project Costing)
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Integrating with PeopleSoft Billing

Understanding the Billing Process

This section discusses:
* System preparation.

¢ Process overview.

* The Contracts/Billing Interface process.

» The billing interface process.

* PeopleSoft Billing worksheet approval.

* PeopleSoft Billing worksheet deletion.

* The Finalization process.

* The Projects/Contracts Interface process.

* Contract Liability accounting.

System Preparation

PeopleSoft Proposal Management integrates with PeopleSoft Contracts, PeopleSoft Project Costing,
and PeopleSoft General Ledger to enable bill processing. Before you can perform the billing activities

associated with expenditures, you need to set up the billing control tables used by the various

applications.

PeopleSoft applications rely on tables to store not only business transactions, but also the structure and

processing rules that drive the system. Before you can run the processes to generate invoices, you need to
establish the structure that tells the system how you want those processes to work.

Before you run the billing processes or manage billing for your awards, you must prepare your PeopleSoft

system accordingly.

Make sure you complete these steps before you initiate the billing processes:

Step

Navigation

Set installation options for PeopleSoft Billing.

Select Set Up Financials/Supply Chain > Install >
Installation Options > Billing Integration Options.

Copyright © 1988, 2022, Oracle and/or its affiliates.

99



Integrating with PeopleSoft Billing Chapter 11

Step Navigation

Define a PeopleSoft Billing business unit. Select Set Up Financials/Supply Chain > Business Unit
Related > Billing > Billing Definition > Business Unit 1.

Define a distribution code for contract asset. Select Set Up Financials/Supply Chain > Common
Definitions > Distribution Accounting > Distribution
Code.

Create a proposal and generate the contract. Select Proposal Management > Proposal and Version >

Maintain Proposal. Click the Generate button on the
Maintain Proposal page.

Change the status on the contract to Active. Select Customer Contracts > Create and Amend >
General Information > General.

Change the status on the billing plan to Ready. Select Customer Contracts > Create and Amend >
General Information > General.

Click the Billing Plans link. Then click the Plan ID link.

Create billable rows in PeopleSoft Project Costing (use either | Select Project Costing > Cost Collection. Then select the
method): feeder system from which you want to retrieve information.

*  Populate the Project Resource table (PROJ_RESOURCE) | OR

through the Project Integration process.
Select Project Costing > Transaction Definitions > Add
*  Add transactions directly into PeopleSoft Project Costing. | Transactions.

Note: The methods for creating billable rows described are for
rate-based billing only.

Process Overview

For rate-based billing in PeopleSoft Proposal Management, the Contracts/Billing Interface process
(CA_BI INTFC) selects resource rows from PeopleSoft Project Costing. You can select contract lines in
PeopleSoft Contracts with ready bill plans to create bill lines in the Billing Interface INTFC_BI and its
related tables). After the Contracts/Billing Interface process stages billing data in these tables, the billing
interface processes the data to create bills.

The billing interface can create two types of bills:
*  Temporary bills

These bills are routed to the billing worksheet, where your billing administrator can review and, for
rate-based bills, amend them as needed before real bills are created. You cannot amend fixed-amount
bills in the billing worksheet.

¢ Real bills
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These bills become invoices that are sent to the customer. You select the option to create temporary

or real bills for individual billing plans on the Billing Plan - Billing Plan General page in PeopleSoft
Contracts.

You can use the billing worksheet to cancel temporary bills. When you cancel a temporary bill from
within the billing worksheet, the system updates PeopleSoft Project Costing and PeopleSoft Contracts
accordingly.

After you review a temporary bill on the billing worksheet, you can create a real bill. The system
creates a real bill after a user approves it and saves the worksheet. When the bill is finalized, the system

updates the Project Resource table (PROJ_ RESOURCE) and the Contracts/Billing Interface Xref table
(CA_BP XREF).
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This flowchart illustrates the Billing Interface process (BIIF0001) Transactions are passed from Contracts
and Project Costing by the CA_BI_INTFC process to Billing, where the invoices or letter of credit
amounts are finalized. The billed data is then passed back to Contracts and Project Costing updating the
CA_BI_XREF and PROJ_RESOURCE tables, respectively.

.

Billing Engine
(CA_BI_INTFC)

i A

Billing Interface
{BIIFOD01) ‘L

Cancel

Billing Worksheet

E——

Real Bill 4——Accept—

!

Finalization
(BIVCOO0D)

!

Projects/Contracts
Interface (BIPCCOQ0)

Updates in PeopleSoft Project Costing and PeopleSoft Contracts are made throughout the billing cycle for
rate-based and fixed-fee billing plans.

"Understanding PeopleSoft Billing Integration with Contracts, Project Costing, Grants, and Pay/Bill
Management" (PeopleSoft Billing)
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The Contracts/Billing Interface Process

Run the Contracts/Billing Interface process in PeopleSoft Contracts to send billing activity in Projects to
PeopleSoft Billing. The contracts that you set up control the billing activity that the system selects from
PeopleSoft Project Costing.

Instructions about running the Contracts/Billing Interface process are in the PeopleSoft Contracts.

Related Links
"Understanding the Contracts Billing Process" (PeopleSoft Contracts)

The Billing Interface Process

Run the Billing Interface process in PeopleSoft Billing to create the temporary bills that you can work
on in the billing worksheet. The billing worksheet is a temporary work area in which you can review and
adjust billing lines from the Billing Interface process before you create actual bills.

After making adjustments, use the Billing Worksheet component to approve or delete temporary bills.
Instructions about running the Billing Interface process are in the PeopleSoft Billing.

Related Links

"Understanding the Billing Interface Process (BIIFO001)" (PeopleSoft Billing)

"Correcting Billing Interface Errors” (PeopleSoft Billing)

"Understanding PeopleSoft Billing Integration with Contracts, Project Costing, Grants, and Pay/Bill
Management" (PeopleSoft Billing)

Billing Worksheet Approval

When you accept a bill in the billing worksheet, the system creates a real bill with a real invoice number,
and updates PeopleSoft Contracts and PeopleSoft Project Costing accordingly.

Instructions about approving billing worksheets are in the PeopleSoft Billing.

Related Links
"Processing Billing Worksheets" (PeopleSoft Billing)

Billing Worksheet Deletion

When you delete a bill in the billing worksheet, the system cancels the bill and updates PeopleSoft
Contracts and PeopleSoft Project Costing accordingly.

Instructions about deleting billing worksheets are in the PeopleSoft Billing.

Related Links
"Processing Billing Worksheets" (PeopleSoft Billing)
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The Finalization Process

Run the Finalization process (BIIVC000) on the real bills that you create. This process performs a variety
of tasks, including calculating taxes and the due date.

Instructions about running the Finalization process are in the PeopleSoft Billing.

Related Links

"Running the Pro Forma, Finalization, Print, and Reprint Processes" (PeopleSoft Billing)

The Projects/Contracts Interface Process

After you run the Finalization process, run the Billing to Projects/Contracts Interface process
(BIPCCO000). This process updates PeopleSoft Contracts and PeopleSoft Project Costing with the
finalized bill information from PeopleSoft Billing.

Instructions about running the Projects/Contracts Interface process are in the PeopleSoft Billing.

Related Links
"Running the Billing to Project Costing/Contracts Interface Process (BIPCC000)" (PeopleSoft Billing)

Contract Liability Accounting

In some cases, you may want to create and send invoices for products or services that you will deliver in
the future or over a range of time. You can use contract liability accounting to generate accounting entries
that defer revenue recognition based on a revenue recognition date and method of your choosing.

You can establish date range contract liability calculation method defaults at the system, business unit, or
bill type level, according to your business needs. PeopleSoft Billing supports five calculation methods for
creating accounting entries for contract liability of transactions when the recognition basis is a date range:

* Spread by days within range.

e Spread evenly across all periods.

* Spread evenly using a mid-period rule.

* Spread partial periods by days with remainder spread evenly.

e User-defined proration.

Related Links
"Understanding the Contract Liability Accounting Process" (PeopleSoft Billing)

104 Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 12

Integrating with Other PeopleSoft

Applications

Understanding Integration Process Flows

This diagram shows the integration touch points between PeopleSoft Proposal Management and
PeopleSoft Program Management, Project Costing, Contracts, Customer Relationship Management,
Payables, General Ledger, Purchasing, Receivables, Resource Management, Billing, Time and Labor, and

Inventory.
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Understanding the Procurement Process

You can enter requisitions into PeopleSoft Purchasing, and then pull them into PeopleSoft Project Costing
for tracking purposes.

This diagram shows the procurement process flow associated with requisitions when PeopleSoft Project
Costing is integrated with PeopleSoft Purchasing, PeopleSoft Payables, and PeopleSoft Inventory.

Project Costing
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Integrating with PeopleSoft Customer Relationship Management

106

Customers using PeopleSoft CRM Sales and Collaborative Selling can initiate service-based proposals
from within PeopleSoft CRM through an interface with PeopleSoft Proposal Management. For
opportunities requiring manual entry, you can create and price multiple service-based proposals. You can
build each proposal using resource inputs at the project activity level.

The following sections describe the integration points:

Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 12 Integrating with Other PeopleSoft Applications

Proposal Integration

Proposal Integration consists of two application messages: OC_ESA PROPOSAL and

OC_ESA PROPOSAL RESPONSE. When an order or quote is submitted for a service type engagement
in PeopleSoft CRM, the system sends the proposal request message (OC_ESA PROPOSAL) to
PeopleSoft Proposal Management.

In response to this message, PeopleSoft Proposal Management sends a message
(OC_ESA PROPOSAL _ RESPONSE) to PeopleSoft CRM to return the Capture ID, Proposal ID, and
Version ID.

The system sends these fields from PeopleSoft CRM to PeopleSoft Proposal Management:

Source = CRM Target = PeopleSoft

Proposal Management
Record Field Record Field
RO _HEADER CAPTURE _ID GM_PROPOSAL CAPTURE _ID
BUS_UNIT _TBL_RO BUSINESS_UNIT _ESA GM_PROPOSAL BUSINESS_UNIT
RO LINE PRODUCT ID GM_PROPOSAL PRODUCT ID
PROD_ITEM DESCR GM_PROPOSAL PRODUCT_DESCR
RO_LINE PRICE GM_PROPOSAL PRICE
RO _LINE CURRENCY_CD GM_PROPOSAL CURRENCY_CD
RO_NOTE DESCRLONG GM_PROP_COMMENT DESCRLONG
RB INT CUST ADS CUST ID GM_PROPOSAL CUST ID
RSF_OPPORTUNITY or RSF | SALES_USER NAME GM_PROPOSAL SALESREP NAME
_LEAD
Note: System uses either
record depending on if
the quote has a lead or an
opportunity attached.
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Source = CRM

Target = PeopleSoft
Proposal Management

Note: System uses
PeopleCode to retrieve phone
and extension information.

Not a direct read of a record.

CC_PHONE_EXTENSION

GM_PROPOSAL

CC_PHONE_EXTENSION

Note: System uses
PeopleCode to retrieve email
address information. Not a

direct read of a record.

EMAIL_ADDR

GM_PROPOSAL

EMAIL_ADDR

RO_ASSOCIATION

PROPOSAL_ID

GM_PROPOSAL

PROPOSAL_ID

RO_ASSOCIATION VERSION_ID GM_PROPOSAL VERSION_ID
RO_HEADER QUOTE_EXPIRE_DT GM_PROPOSAL DUE_DATE
RO_HEADER DESCR50 GM_PROPOSAL PROPOSAL _TITLE
RO_HEADER CAPTURE_DATE GM_PROPOSAL BEGIN DT
RO_HEADER QUOTE_DUE_DATE GM_PROPOSAL END DT

In response to the first message, the system sends these fields from PeopleSoft Proposal Management to

PeopleSoft CRM:

Source = PeopleSoft Target = CRM

Proposal Management

Record Field Record Field
ESA_OC_RSPN PROPOSAL_ID RO_ASSOCIATION PROPOSAL_ID
ESA OC _RSPN VERSION ID RO _ASSOCIATION VERSION ID
ESA_OC_RSPN CAPTURE_ID RO_ASSOCIATION CAPTURE_ID

ESA OC_RSPN BUSINESS UNIT RO_ASSOCIATION ASSOC _BUS UNIT
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Source = PeopleSoft Target = CRM
Proposal Management
ESA_OC_RSPN MESSAGE_TEXT NA NA

Note: The system uses the MESSAGE TEXT field to log error messages if any errors occur when the
proposal is being created or updated.

PeopleSoft Proposal Management uses the customer number to query the customer table for customer
name and current contact information. When PeopleSoft Proposal Management receives the message, the
following occurs:

» If'the proposal ID is blank, the system creates a new proposal.
» If'the proposal ID is not blank, the system updates the existing proposal.
* Ifaquote in PeopleSoft CRM has expired, it may be revised in CRM.

This creates a new quote with a new capture ID. The system then passes the proposal ID to PeopleSoft
Proposal Management from the original quote. PeopleSoft Proposal Management checks if the
proposal has been closed out (proposal status equals Canceled). If it has been closed, the system
reopens the proposal for pricing (proposal status is updated to Draft).

Quote Integration

When pricing information is completed in PeopleSoft Proposal Management, the Quote Integration
application message (ESA  PROPOSAL PRICE) sends pricing information back to PeopleSoft CRM.
This occurs when a user clicks the Set To Ready button on the Maintain Proposal page in PeopleSoft
Proposal Management. After the system sends the message to PeopleSoft CRM, the selected proposal
version is locked and uneditable.

The system sends these fields from PeopleSoft Proposal Management to PeopleSoft CRM:

Source = PeopleSoft Target = CRM
Proposal Management
Record Field Record Field

GM_PROPOSAL

PROPOSAL ID

RO_ASSOCIATION

PROPOSAL ID

GM_PROPOSAL

VERSION_ID

RO_ASSOCIATION

VERSION_ID

GM_PROPOSAL

BUSINESS_UNIT

RO _HEADER

BUSINESS_UNIT

GM_PROPOSAL

TOTAL BUDGET AMT

RO _LINE

PRICE

Copyright © 1988, 2022, Oracle and/or its affiliates.

109



Integrating with Other PeopleSoft Applications Chapter 12

Source = PeopleSoft Target = CRM
Proposal Management
GM_PROP_COMMENT DESCRLONG RO NOTE DESCRLONG

Note: PeopleSoft Proposal Management sends note descriptions to PeopleSoft CRM, but PeopleSoft
CRM does not update them.

Sales Integration

The system triggers the Sales Integration application message (OC_ESA PROPOSAL_ STATUS) from
PeopleSoft CRM when a sales lead or opportunity is lost or sold, when the direct quote or order is sold,
when the quote or order line is canceled (quotes expire after a specified time interval), or when the order
line needs to be repriced.

When PeopleSoft Proposal Management receives the message, it updates the corresponding proposal
version with either the Draft, Denied, or Committed status, which is based on the contents of the message.
The system sends these fields from PeopleSoft CRM to PeopleSoft Proposal Management:

Source = CRM Target = PeopleSoft

Proposal Management
Record Field Record Field
RO_ASSOCIATION PROPOSAL_ID GM_PROPOSAL PROPOSAL_ID
RO _ASSOCIATION VERSION ID GM_PROPOSAL VERSION ID
RO _ESA BU BUSINESS_UNIT_ESA GM_PROPOSAL BUSINESS_UNIT
RO HEADER CAPTURE ID GM_PROPOSAL CAPTURE ID
RO _LINE.STATUS STATUS CODE GM_PROPOSAL SUBMIT_STATUS
RO NOTE DESCRLONG GM_PROP_COMMENT DESCRLONG

When PeopleSoft Proposal Management receives the message, the following occurs:
» If'the order capture line status is Lost, the system updates the proposal status to Denied.
» If the order capture line status is So/d, the system updates the proposal status to Committed.

» If'the order is expired, the system updates the proposal status to Canceled.
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» If'the order capture line status is Negotiate, the system updates the proposal status to Draft and
enables re-pricing for the related proposal version.

Statuses

This table shows how statuses from both PeopleSoft Proposal Management and PeopleSoft CRM

correspond to each other:

PeopleSoft Proposal Management Status PeopleSoft CRM Status
Draft Draft

Ready Priced

Draft Negotiate

Denied Lost

Committed Sold

Canceled Expired
Installation

To activate integration between PeopleSoft CRM and PeopleSoft Proposal Management, you must

activate these messages at the message level:

« OC _ESA PROPOSAL

« OC_ESA PROPOSAL RESPONSE

+ ESA PROPOSAL PRICE

« OC_ESA PROPOSAL STATUS

See the product documentation for PeopleTools: Integration Broker

Integrating with PeopleSoft Contracts, PeopleSoft Project
Costing, and PeopleSoft Program Management

Through the Generate process, PeopleSoft Proposal Management writes data to PeopleSoft Contracts,
PeopleSoft Project Costing, and PeopleSoft Program Management.

The system writes data to these Contract tables during the Proposal Management Generate process:

- CA_CONTR_HDR
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CA BILL PLAN
CA_ACCTPLAN

CA DETAIL

CA DTL DST DATE
CA_DETAIL DST
CA DETAIL UAR
CA DETAIL DFR
CA RATE

CA_DETAIL PROJ

Chapter 12

The system writes data to these PeopleSoft Project Costing and PeopleSoft Program Management tables

during the Proposal Management Generate process:

PROJECT
PROJ_ACTIVITY
PC_BUD ITEM
PC_RATE

PC_RATE DTL
PC_RATE DTL LN
PROJECT TEAM
PROJ TEAM_SCHED
PROJ ACT TEAM
PC_TEAM_IP_SCHD
PC_BUD PLAN

PC_BUD DETAIL

PeopleSoft Project Costing integrates with both PeopleSoft Billing and PeopleSoft Contracts, so any
adjustments, discounts, released retainages, or limits created for project-related bills are inherited from

corresponding bills and contracts.

PeopleSoft Proposal Management writes general project information, project activity information, and

budget information directly into PeopleSoft Project Costing.

Note: Your organization may customize additional validation checks and required fields based on your
internal project approval requirements. You may also decide to build interfaces that populate or update
project records and customer internet sites, EDI transaction sets, and data warehouses, since web sites and
EDI transaction sets often incorporate data elements that are included in the PeopleSoft Project Costing

pages.
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Related Links
"Establishing Project Profiles" (PeopleSoft Grants)
"Establishing Project Activities" (PeopleSoft Grants)

Integrating with PeopleSoft Time and Labor

Using tables, enterprise integration points, and other processes delivered with PeopleSoft Project Costing
and PeopleSoft Time and Labor, the system brings labor costs into PeopleSoft Project Costing anytime
PeopleSoft Project Costing needs estimates for billing.

To enable data transfer from PeopleSoft Time and Labor to PeopleSoft Project Costing during a payroll
period, PeopleSoft Time and Labor uses an estimation process linked with North American Payroll to
summarize hours and labor expenses. These estimates are brought into PeopleSoft Project Costing as
transactions with an analysis type of TLA (Time and Labor Accruals). To facilitate billing from estimates,
Time and Labor for Billing (TLB) rows are created during estimate processing. The monetary amounts

of these estimates are close to what the eventual pro rata amounts will be after the payroll close, but are
subject to change.

It is important to remember when setting up integration between PeopleSoft Project Costing and
PeopleSoft Time and Labor that you are working in two separate databases: Financials and HCM.
Therefore, information must be present in both databases before you can begin.

There are six project prompt tables (along with the Project Team and Project Status tables) in PeopleSoft
Time and Labor that are populated by integration with PeopleSoft Project Costing.

Note: The prompt tables are synchronized between PeopleSoft Financials and HCM using application
messaging. Refer to the enterprise integration documentation for more information.

Related Links
"Understanding Integration with PeopleSoft Time and Labor" (PeopleSoft Project Costing)

Integrating with PeopleSoft General Ledger

PeopleSoft Project Costing has a built-in integration with PeopleSoft General Ledger through the Journal
Generator for both single-sided transactions and double-sided transactions.

Single-Sided Transactions

After you create accounting entry templates to generate double-sided entries, run the Process Accounting
process. The Process Accounting process uses the accounting entry templates to generate double-sided
entries and writes them to the CA_ ACCTG_LN_PC table.

You then distribute the transactions to PeopleSoft General Ledger. Run the Journal Generator using the
PC_COSTS run control with the PCDEFN accounting entry definition specified. This distributes the
transactions to the Journal Header Data (JRNL HEADER) and Journal Line Data (JRNL LN) tables in
PeopleSoft General Ledger.
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Double-Sided Transactions

Accounting entry templates are not necessary for distributing double-sided transactions. To distribute
double-sided transactions created through the Resource Adjustments page in PeopleSoft Project Costing,
run the Journal Generator using the PC_ADJUST run control with the PCDEFN accounting entry
definition specified. This distributes the transactions to the Journal Header Data and Journal Line Data
tables in PeopleSoft General Ledger.

You can then retrieve posted journals back to PeopleSoft Project Costing with the PeopleSoft General
Ledger to Projects Interface process (PC_GL _TO PC).

Related Links
"Understanding Integration with PeopleSoft General Ledger" (PeopleSoft Project Costing)

Integrating with PeopleSoft Commitment Control

PeopleSoft Commitment Control is an optional feature of Oracle's PeopleSoft Financial Management
(FMS), Oracle's PeopleSoft Enterprise Service Automation (ESA), and Oracle's PeopleSoft customer
Relationship Management (SCM) product lines that enables you to control expenditures actively against
predefined, authorized budgets. In particular, PeopleSoft Commitment Control enables you to:

* Create and maintain control budgets.
* Check actual transactions (such as actual expenditures and revenues) against control budgets.

*  Check imminent future financial obligations (pre-encumbrances and encumbrances) against control
budgets.

*  Check recognized revenue against revenue estimate budgets.

When you set up your control budgets, you associate them with a particular PeopleSoft General Ledger
business unit and designate amounts for them. You also define which kinds of transactions you will check
against your control budgets. After your budgets are established, you check all of these transactions
against your budgets, passing or failing the transactions, depending on the remaining available budget
amount and the degree of budgetary control you set up for your budgets.

Related Links
"Integration of Commitment Control with Third-Party Applications" (PeopleSoft Commitment Control)

Integrating with PeopleSoft Receivables

114

The integration of PeopleSoft Receivables with PeopleSoft Project Costing provides project managers
with accounts receivable items and revenue related adjustments. As a result, project managers have
information about the progress of a project in terms of the outstanding revenue.

The Receivables to Projects process (PC_AR _TO_PC) moves data from PeopleSoft Receivables to
PeopleSoft Project Costing. The system identifies entry type and system functions for revenue related
adjustments in AR and only those rows are moved to the Project Resource table.
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Related Links
"Understanding Integration with PeopleSoft Receivables" (PeopleSoft Project Costing)

Integrating with PeopleSoft Purchasing

Data flows both ways between PeopleSoft Project Costing and PeopleSoft Purchasing. You can enter
requisition lines directly into PeopleSoft Project Costing, retrieve them with the Purchasing Requisition
Loader, and then process them as requisitions in PeopleSoft Purchasing. Requisitions entered through
another means into PeopleSoft Purchasing can be brought into PeopleSoft Project Costing as requisition
lines. You can also pull transactions representing materials for which purchase orders have been created
into PeopleSoft Project Costing as committed costs.

Use the Purchasing to Projects process (PC_PO_TO_PC) to pull requisitions or purchase orders into
PeopleSoft Project Costing.

Related Links
"Understanding Procurement Costs" (PeopleSoft Project Costing)

Integrating with PeopleSoft Inventory

After you identify an item on a requisition as an inventory item by the PeopleSoft sourcing routine, you
can check purchasing availability directly from PeopleSoft Purchasing or create a demand and place it on
the Inventory Demand Interface table (DEMAND_INF INV), where PeopleSoft Inventory picks it up.

PeopleSoft Inventory then determines whether the demand can be fulfilled. If it cannot be fulfilled, it is
sent back to PeopleSoft Purchasing and a purchase order is generated or the demand is back ordered. If
the demand can be fulfilled, the requested items are assigned to the Project ID identified on the demand.
The fulfilled demand is then placed via Inventory Costing on the Invoice Accounting Distribution table
(CM_ACCTG_LINE), where it is picked up by PeopleSoft Project Costing and brought in as a resource
transaction with an analysis type of ACT.

Use the Inventory Process Request page to pull fulfilled demands into PeopleSoft Project Costing from
PeopleSoft Inventory.

Related Links
"Integrating with PeopleSoft Inventory" (PeopleSoft Project Costing)

Integrating with PeopleSoft Payables

After you create a purchase order in PeopleSoft Purchasing, the system sends it to PeopleSoft Payables.
When you enter vouchers into PeopleSoft Payables for bills received, they go through a matching process.
After the system matches a voucher, it also approves and posts it to the Accounts Payable Accounting
Entries table (VCHR ACCTG_LINE). From this table, you can pull vouchers that carry a PC distribution
status of N into PeopleSoft Project Costing. The analysis type ACT appears by default.
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Use the Payables Process Request page to run the Accounts Payable to Projects Interface process
(PC_AP_TO PC), and pull approved vouchers into PeopleSoft Project Costing from PeopleSoft Payables.

Related Links
"Integrating with PeopleSoft Payables" (PeopleSoft Project Costing)

Integrating with Third-Party Systems

PeopleSoft Project Costing integrates with third-party systems by giving you the ability to pull data
elements from those systems into corresponding fields and tables in PeopleSoft Project Costing. The
requirements include the ability to export the information from the third-party systems into a database
table or a flat file, and then import that information into the PeopleSoft Project Costing interface tables.
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PeopleSoft Proposal Management Reports: A to Z

This table lists all of the reports provided with PeopleSoft Proposal Management, sorted alphanumerically
by report ID.

Note: For samples of these reports, see the Portable Document Format (PDF) files that are published with
your online documentation.

PeopleSoft Proposal Management Proposal Reports

Report ID and Report Name Description Run Control Page

PM1100 Review proposed resource for a RUN_GM_PROP_RPT
particular proposal.

Fixed Fee

PM1110 Review proposed resource for RUN_GM_PROP_RPT
a particular proposal, including

Fixed Fee Itemized (BI Publisher) adjustments.

PM1120 Review proposed resource for a RUN _GM PROP_RPT
particular proposal, including bill, cost

Internal and margin rates.

PeopleSoft Proposal Management Resource Demand Report

Report ID and Report Name Description Run Control Page

PM1310 Analyze the demand on resources for RUN _GM_RES RPT
future months according to project role

Resource Demand by Role Report and specified criteria.
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PeopleSoft Proposal Management Revenue Pipeline Reports

Report ID and Report Name Description Run Control Page

PM1200 Review the expected revenue for a RUN_GM_PL RPT
particular time period. The report lists,

By Confidence Report in Tenths by tenths, the proposals that fall into the

confidence range that you specify.

PM1210 Review the expected revenue for a RUN _GM_PL RPT
particular time period. The report lists,
By Confidence Rpt in Quartile by quarters, the proposals that fall into

the confidence range that you specify.

PM1410 Review the expected revenue for RUN_GM_PL RPT
a particular time period by status

By Status Report according to specified criteria.

PM1400 Review the expected revenue for a RUN_GM_PL RPT
particular time period by customer name

By Customer Name Report according to specified criteria.
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